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В цифровом мире, где большая часть чего бы то 
ни было подделана или как-то обработана, 
желание ещё более реалистичных эффектов и 
моделей, фальшивых или нет — это то, что всегда 
преследует художников CG. В особенности это 
касается волос/меха, имитации воды и 
реалистического модификатора ткани, вот 
некоторые названия.

И хотя большая часть прекрасных изображений 
и анимации не использует высококлассных техник, 
инструментов и эффектов, но в какой-то момент 
все художники CG желают поиграть с этими концеп-
циями, даже не имея другой причины кроме как 
«это круто!»

Художники CG понимают, что не каждое 
желание исполнимо, но к счастью для нас 
разработчики Blender-а очень талантливы и дают 
нам много этих желаемых вещей.

Да, именно нам!
The Peach project (Big Buck Bunny) дал нам 

некоторые очень хорошие улучшения системы 
частиц, пригодные для создания прекрасных 
волос/меха. Будучи правильно настроенными, они 
выглядят такими мягкими, что просто хочется 
дотянуться и дотронуться до них.

Спустя годы разработки наш долгожданный мо-
дификатор ткани всё-таки появился. Новый моди-
фикатор ткани возвещает наступление новой эпохи 
тестовых изображений, заполненных красиво  дра-
пированной одеждой, развевающимися флагами и 
всеми видами трепещущей ткани.

И кто может устоять перед искушением создать 
сцену огромного потопа или приливной волны, 
разрушающей всё вокруг? Или ещё лучше — 
создание прекрасных работ жидкого искусства 
(Fluid art).

В этом номере мы покажем как пользоваться 
некоторыми из этих превосходных инструментов, а 

также как создать некоторые очень крутые 
эффекты. Так что найдите ваше любимое кресло и 
приготовьтесь к превосходному чтению.

Счастливого блендинга!
sandra@blenderart.org

Sandra Gilbert
Выпускающий

редактор
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Иззи говорит: DVD, новые релизы, ОМГ!

Big Buck Bunny:
ОМГ! Его так быстро прислали. Я думал, что 

получу свою копию на несколько недель позже. У 
меня были планы на тот день, но я всё бросил и 
пошёл смотреть ВВВ. Я просто не мог больше 
ждать! 

Я не собираюсь пересказывать сюжет для тех, 
кто не посмотрел его, только скажу, что мне он 
показался очень смешным. Персонажи индивиду-
альны, отлично проработаны, было очень весело 
наблюдать за сменой их эмоций, за их движениями 
и общением друг с другом. 

Выглядит ВВВ очень красиво. Все животные 
выглядели такими мягкими и пушистыми, что мне 
хотелось взять и погладить их. Окружение было в 
мягких и сказочных цветах. Можете быть уверены, 
я буду копаться в исходных файлах, чтобы найти 
все секреты текстуринга и материалов. 

Вообще, я буду учиться на исходных файлах 
(уверен, что все будут) не только, чтобы увидеть, 
как же они сделали такие материалы и шерсть, но 
и освещению я тоже поучусь. 

У меня пока не было времени посмотреть все 
файлы и бонусы на DVD, но, быстро просмотрев 
контент, я удостоверился, что там есть много 
интересных вещей. Если вы ещё не заказали 
копию, я призываю вас сделать это как можно 
скорее. Вы не пожалеете.

О новых игрушках: 
Хотя я слежу за развитием и разработкой 

Блендера, с моим графиком у меня часто не 
хватает времени, чтобы поковырять тестовые 
билды. Даже хуже — когда руки доходят до нового 
релиза, нет времени просто сесть и изучить новые 
фичи. Как и многие из нас, я изучаю и открываю 
для себя новые возможности по мере надобности. 

И мои недавние проекты для их реализации не 
требовали каких-то крутых фич. Вот (наверное, 
надо думать о более сложных проектах, чтобы 
открывать для себя новые возможности). 

С релизом 2.46 моё свободное время не 
увеличилось, но появилось слишком много новых 
вкусных возможностей, чтобы сопротивляться. 
Итак, после быстрого обзора моих старых файлов в 
поисках удобной для экспериментов модели, я сел, 
что весело поблендерить. Тссс! только не говорите 
никому, они все думают, что я делаю что-то 
продуктивное. 

Вот мои впечатления. Я не часто сижу, тупо жму 
кнопки и смотрю, что происходит — это может 
занять уйму времени. 

Некоторое время спустя... ну ладно, 2-3 часа 
спустя (я веселился!)

Модификатор ткани (Cloth Modifier): Хоть я 
и не модельер, но я интересно провёл время, 
играясь с очень простым пончо (простой круг, 
подразделённый и слегка изменённый в форме). 
Это не было каким-то целенаправленным тестом, 
просто весело было тыкать дефолтные настройки и 
смотреть, как ткань падает и одевается на моего 
персонажа. Можно получить неплохие результаты 
даже ничего не настраивая, а просто использовать 
пресеты. 

Было интересно видеть, как результаты 
действия пресетов отличаются друг от друга. 
Конечно, весело было играть с падающим пончо 
долгое время. Но я начал ставить опыты на неком 
подобии халата, добавил ветер. Я смотрел, как 
халат развевается на ветру, менял направление 
ветра (да, меня очень легко занять). Больше всего 
мне понравилось наблюдать за шёлком. Его замеча-
тельное скользящее качество заставляло одежду 
буквально плыть вокруг персонажа. Резина тоже 

4

Все животные выглядели 
такими мягкими и пушистыми, 

что мне хотелось взять и 
погладить их.
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была довольно забавной: когда добавился ветер, 
она шлёпнулась о живот моего персонажа и 
частично обернула его. 

Есть возможность и самому настроить свойства 
тканей, но, если честно, то по-моему большинство 
задач может быть выполнено с помощью пресетов. 
Особенно, если вы просто балуетесь с 
настройками, как я.

Мех/волосы (Система частиц): Так как 
большая часть моих последних персонажей — это 
разные животные, я ждал обновлённую и улуч-
шеную систему частиц. Быстро поискав инструк-
ции, я наткнулся на WIP-туториал. Там было 
несколько хороших подсказок по созданию систе-
мы меха, так что я начал танцевать отсюда. Под 
конец моя модель напоминала кузена бигфута, но, 
по крайней мере, он был лохматый. Замечательное 
развлечение! Кисти редактирования волос заняли 
ещё сколько-то моего времени, которое я потратил 
на переделку его причёски. Определённо, мне 
нужно пойти на курсы парикмахеров... причёска 
моего мальчика была похожа на «утро в 
курятнике» (bad hair day). 

Я бы ещё игрался и открывал новые 
возможности, но потратил так много времени на 
наблюдение за падающей тканью и создание при-
чёски, что на прочие запланированные дела почти 
ничего не осталось. 

Есть ещё куча других вещей, которые хотелось 
бы попробовать: UV Editing, Render Baking, Bone 
Heat weighting и улучшения Armature Drawing... но 
я вернусь к тестированию этого немного позже, 
когда будет больше времени, или когда никто не 
будет смотреть.

ManCandy FAQs: 
В течение последних месяцев (ну, может, 

дольше) я пытался изучить риггинг и анимацию. Я 

правда хотел расширить свои навыки анимации от 
перемещения простых объектов до анимации 
персонажей, поэтому я был реально увлечён 
ManCandy FAQ DVD. Накопив денег по копеечке, я 
в конце концов приобрёл его. После 2-3х 
недельного ожидания доставки, (может показаться, 
что я живу на краю света, когда речь идёт о 
посылках) он, наконец-то, пришёл. Няя!!! 

Я был настолько захвачен, что даже хотя у меня 
были другие дела, я не мог устоять против того, 
чтобы воткнуть DVD в компьютер и получать 
наслаждение. Это было большой ошибкой: стоило 
мне только краем глаза взглянуть на него, как 
сразу же появилось желание сесть и проглотить его 
в один присест. Но у меня было действительно 
много дел, которые надо сделать. Раздолбай! 
Большой раздолбай! 

Эх... в общем, я решил сначала заняться теми, 
другими делами. Прошла одна неделя, потом 
вторая. И всё это время мне некогда было смотреть 
мой новый DVD. Это плохо. Такими темпами я его 
вообще никогда не посмотрю... И тут меня осенила 
гениальная идея. Я взял свой старый ноутбук и 
DVD, притащил их в мастерскую (craft room), 
быстренько установил их и включил воспроизведе-
ние DVD. Теперь я мог слушать DVD, работая в то 
же время над своими проектами. Проблема была 
наполовину решена. 

Я так и не посмотрел ещё большую часть DVD 
(кусочек там, кусочек здесь), но прослушал его 
целиком уже несколько раз. Не самое лучшее 
решение, как я уже говорил, но оно позволило мне 
хоть чему-нибудь научиться. Я, конечно, когда-
нибудь просмотрю его целиком, но это в будущем.

Я долго восхищался способностями и креатив-
ным видением Бассама (Bassam), но после просмот-
ра DVD обнаружил, что он ещё и неплохой (и 
весёлый) учитель. Его стиль обучения близок к 
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долгому и глубокому разговору с другом. Он 
объясняет всё в лёгкой, небрежной манере. Что 
мне действительно понравилось, так это то, что он 
не только объясняет как и почему нужно делать те 
или иные вещи, но и что случится, если сделать их 
неправильно или забыть о чём-то. Он также 
оставляет в своих видео несколько ошибок, а 
потом показывает, как их исправить. 

Бассам упаковал в каждый видеоролик 
неимоверное количество информации. И, несмотря 
на то, что они идут все вместе, они также могут 
рассматриваться по отдельности, как полноценные 
уроки. Я уже прослушал DVD много раз и намерен 
прослушать и просмотреть его много больше. 
Всякий раз, как я «просматриваю» какую-то часть, 
я узнаю что-то новое и моё понимание риггинга 
улучшается, как это бывает только с хорошими 
вещами. 

DVD с ManCandy FAQ стоит потраченных на него 
денег и времени. Теперь, если только я найду 
время, то обязательно сделаю что-нибудь, 
используя свои новоприобретённые знания.
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Введение
Органические материалы, вероятно, яв-

ляются одними из самых сложных в 
настройке, поскольку их реализм не осно-
вывается исключительно на качестве 
текстуры. Текстура кожи часто выглядит 
пластмассовой, а при использовании подпо-
верхностного рассеивания (SSS) становится 
похожей на воск.

Я пытался добиться реализма отренде-
ренной кожи в течение последних не-
скольких недель, или, по крайней мере, 
получить шейдер кожи, который бы не 
выглядел ужасно после рендеринга. Прове-
дя некоторые исследования я начал соби-
рать что-то типа «многослойного» шейдера 
кожи, в котором бы учитывались различные 

слои человеческой кожи. В Blender это означает 
использование отдельного материала для каждого 
слоя кожи (эпидерма, дерма и так далее) и объеди-
нение их в редакторе материалов для получения 
конечного результата.

Часть первая: Расслоение 
диффузии 

Шаг первый: Структура кожи

Во-первых, займемся диффузией нашего мате-
риала: зеркальные отражения мы настроим отдель-
но. Прежде чем пытаться сымитировать вид кожи, 
мы должны разобраться с ее составом:

•  Верхним слоем кожи является эпидерма, кото-
рая слабо рассеивает свет. Ее цвет — желтова-
то-серый. На ступне, например, слой 
эпидермиса довольно толстый и поэтому кожа 
там выглядит почти желтой. 

•  Глубже располагается слой дермы — она почти 
красная из-за присутствия крови. Дерма, в 
отличие от эпидермы, сильно рассеивает свет. 

•  Даже если нижележащие ткани (мускулы, 
органы, хрящи и т.д.) почти незаметны, нам 
необходимо имитировать что-то похожее на 
фоновое рассеивание — когда уши, например, 
освещаются сзади, то они кажутся красными. 
Фоновое рассеивание можно было бы сделать в 
слое дермы, поскольку в панели настроек SSS 
есть параметр Back, который позволяет 
отдельно настроить фронтальное и фоновое 
рассеивание. Но в конечном счете отделение 
фонового рассеивания от рассеивания в слое 
дермы дает больший контроль. 

•  И последнее замечание о структуре кожи: в 
теории, над слоем эпидермы ничего нет. Однако 
использование SSS (даже в очень незначитель-

Подповерхностное рассеивание

Подповерхностное рассеивание, или SSS, — это 
свойство, связанное с полупрозрачностью 
объектов, которые не являются ни полностью 
отражающими, ни полностью прозрачными. От 
отражающих поверхностей лучи света просто 
«отскакивают». Они проходят сквозь прозрач-
ные и однородные объекты, преломляясь два 
раза (при падении на поверхность и при выхо-
де из объекта). Но полупрозрачные объекты 
рассеивают падающий свет, преломляя лучи 
множество раз хаотичным образом до их выхо-
да. Так получается поверхность с очень мягким 
отражением. Объектами, обладающими таким 
свойством, являются, например, молоко, воск, 
помидоры и т.д. Многие органические объекты 
рассеивают свет.А
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ной мере) ослабит действие карты неровнос-
тей в текстурах ваших моделей. Поэтому нам 
необходимо будет добавить еще один слой, 
который будет нерассеивающим диффузным 
слоем. Таким образом можно сохранить все 
неровности текстуры, а этот слой будет ис-
пользован для текстурирования (по части диф-
фузных шейдеров). 

•  Просто взгляните на рисунок, который 
подытоживает все, что нам необходимо 
имитировать. Вооружившись этими знаниями 
мы готовы приступить к работе и настройке 
материалов. 

Шаг второй: 
Нерассеяная 
диффузия

Настройка 
освещения: 
прежде чем на-
чать работу 
над шейдером, 
следует настро-
ить простую, но 
в то же время 
удобную, тесто-
вую сцену. Я 
использовал мо-
дель головы, 
предоставлен-
ную пользова-
телем Maqs на 

форумах BlenderArtists.org, который также дал мне 
разрешение использовать модель в этой статье. Он 
заслуживает благодарности еще и за то, что очень 
помог мне в работе над шейдером. Можно также 
использовать стандартную голову обезьянки 

([клавиша Пробел] Add > Mesh > Monkey) вместо 
модеи Maqs'а или даже использовать голову, 
импортированную из MakeHuman (File > Import > 
Wavefront).

Моя настройка освещения довольно проста: 
основной источник Lamp (Add > Lamp > Lamp) со 
включенными мягкими трассируемыми тенями (ray-
traced shadows) для освещения головы и лампа 
Rim со слегка голубоватым оттенком, освещающая 
объект сзади для подчеркивания контура. 

Теперь мы можем приступить непосредственно к 
созданию шейдера. Добавьте новый материал к 
вашему объекту (панель Materials, add new) и 
переименуйте его в «un-scattered_diffuse». Назначь-
те материалу цвет естественной кожи и установите 
алгоритм диффузного отражения в Oren-Nayar. 
Диффузный шейдер Oren-Nayar во время ренде-
ринга учитывает гипотетические микронеровности 
на поверхности, что позволяет получить грубую по-
верхность как у таких материалов, как глина, А
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одежда, сухие камни и т.д. Поэтому он позволяет 
получить более естественное затенение. Не забудь-
те установить ползунок Spec в значение 0.00, по-
скольку зеркальным отражением мы займемся 
позже. Если вы приготовили несколько хороших 
текстур для вашей модели, то можете назначить их 
сейчас, за исключением текстуры зеркального от-
ражения. Важно понять, что, хотя эпидерма и явля-
ется верхним слоем кожи, мы не будем назначать 
текстуру на этот слой, так как эффект SSS сильно 
размоет эффект неровностей поверхности.

Шаг третий: Слой эпидермы

Теперь что касается слоя эпидермы. Нам пред-
стоит создать шейдер, выглядящий как бескровное 
тело, поскольку кровь протекает в основном в слое 
дермы. В итоге он должен выглядеть серо-желтым 
и иметь небольшой эффект SSS. Добавьте новый 
материал и назовите его «epidermis», подберите 
для него цвет бледной кожи и посмотрите на на-

стройки, которые я использовал для SSS (я не буду 
объяснять все детально, поскольку мы будем 
настраивать три слоя с эффектом SSS, смотрите 
скриншоты). Следует иметь ввиду, что для каждого 
слоя значение цветового охвата для красного 
канала должно быть в два раза больше значения 
цветового охвата зеленого канала, а значение 
цветового охвата синего канала должно быть в два 
раза меньше значения зеленого канала (основыва-
ясь на научных измерениях). Небольшое замечание 
о масштабном значении SSS: теоретически мы дол-
жны использовать одинаковое масштабное зна-
чение для всех слоев, формирующих эффект SSS, 
так как наш объект имеет фиксированные размеры. 
Но поскольку пределы SSS для эпидермы, дермы и 
слоя фонового рассеивания сильно отличаются, это 
приведет к необходимости установки малого значе-
ния SSS для эпидермы и больших значений для 
остальных слоев. Действовать таким образом было 
бы не совсем точно, и, поскольку мы работаем по-
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шагово, будет удобнее настроить каждый слой от-
дельно, не обращаяя внимания на одинаковое мас-
штабное значение для каждого слоя.

Шаг четвертый: Слой дермы

В реальности слой дермы имеет красный или 
оранжевый цвет из-за крови, протекающей по это-
му слою. После объединения всех диффузных 
слоев нам будет необходимо увидеть кровь, нахо-
дящуюся под кожей. Поэтому добавте еще один 
материал, назовите его «dermis» и подберите для 
него красно-оранжевый оттенок. В отличие от 

эпидермы слой дермы должен сильно рассеивать 
свет, поэтому придется установить намного боль-
шее масштабное значение SSS. Взгляните на рису-
нок с настройками, которые я использовал. 
Обратите внимание, что ползунок Back установлен 
в 0.00, так как для фонового рассеивания мы будем 
использовать отдельный шейдер. И, опять же, не 
забудьте установить ползунок Spec в нулевое 
значение.

Шаг пятый: Фоновое рассеивание

Теперь мы можем настроить фоновое рассеива-
ние. Я предпочел отделить его от слоя дермы. Этим 
мы добились большего контроля над подповерх-
ностным рассеиванием. Добавьте еще один матери-
ал и назовите его, скажем, «back_scattering», 
подберите для него почти черный цвет, но не 
чистый черный — если ваш шейдер или текстура 
имеют чистый черный цвет, то ничего не будет 
рассеиваться, поскольку любой цвет, умноженный 

Замечание

Цвет SSS установлен синим. На самом деле, я обра-
тил внимание, что выбор такого цвета для SSS при-
водит к тому, что терминаторы (переходные 
области между светом и тенью) приобретают допол-
нительный оранжевый оттенок, а это именно то, 
что мне и было нужно.А
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на черный, становится черным (чистый черный 
цвет имеет значения [0, 0, 0]). Теперь на панели 
SSS установите красный цвет и большое 
масштабное значение. Оно на самом деле зависит 
от размеров вашей модели, в моем случае я хотел 
добиться красноватого оттенка на ушах, но не 
слишком сильного (в противном случае возникло 
бы ощущение, что модель была совсем 
крошечная). Обратите внимание, что значение 
Back установлено на максимум, а Front равно 0. 
И, опять же, значение Spec установите нулевым.

Шаг шестой: Объединение всех диффузных 
слоев с помощью нодов материалов

Приступим: добавьте новый материал и 
назовите его «Combined_shaderы», нажмите 
кнопку Node. Откройте редактор нодов 

материалов и загрузите в него все материалы, 
созданные ранее (Пробел > Add > Input > 
Material). Выполните это четыре раза и для каждой 
ноды назначьте один из материалов кожи. Теперь 
можно свести все слои вместе. Добавьте новый 
оператор смешивания (Пробел > Add > Color > Mix) 
и измените режим смешивания с Mix на Screen. 
Теперь соедините блок, содержащий слой эпидер-
мы, с первым входом оператора Screen, и блок, 

содержащий слой дер-
мы, со вторым входом. 
Коэффициент смешива-
ния оставьте по умол-
чанию равным 0.50. 
Теперь выполните то 
же самое с материалом 
«Back_scattering», но 
оператор смешивания 
оставьте на этот раз в 
режиме Add.

Фоновое рассеива-
ние будет черным за 
исключением тех мест, 
где модель освещена 
сзади. Устанавливая 
оператор смешивания 
в режим Add, мы мо-
жем быть уверны, что 
темные области в фо-
новом рассеивании не 

Параметр Error: для тестовых рен-
деров лучше установить его в 
районе 0.5 или даже 1.0. Для 

финальных рендеров можно сделать его равным 
0.1 или даже 0.05, если вам так хочется получить 
более точные вычисления или изображение боль-
шого размера.

Замечание
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повлияют на отрендеренное изображение, посколь-
ку чистый черный цвет ([0, 0, 0]) ничего не изме-
няет. Значение Fac должно быть равно 1.0, иначе 
фоновое рассеивание не будет добавлено полнос-
тью. Ели же вы заметите, что эффект фонового 
рассеивания слишком велик, то вместо изменения 
настроек SSS материала можно уменьшить значе-
ние Fac оператора смешивания. И, наконец, 
объедините слой «unscattered_diffuse» с остальны-
ми слоями оператором Screen.

На этот раз я установил значение Fac равным 
0.60. Вы сами можете решить какого типа кожу хо-
тите видеть: более прозрачную или с более силь-
ным отражением, которая поглощает мало света. 
Соедините ноду Screen c материалом Output.

Вы, возможно, обратили внимание, что я доба-
вил контроллер RGB Curves после сведения слоев 
дермы и эпидермы. На самом деле настройка цвета 
кожи таким образом более удобна, чем изменение 
параметров SSS в панели материалов. И последнее 
замечание об операторе Screen: теоретически, мы 
должны использовать оператор Mix для объедине-
ния слоев, поскольку мы всего лишь хотим увидеть 
все слои одновременно. Однако оператор Screen 
дает лучший результат, так как при использовании 
оператора Mix кожа выглядит плоской. Думаю, 
лучше использовать оператор Screen тогда, когда 
настройки освещения не сильно, образно говоря, 
экстремальны. В экстремальных условия освеще-
ния, например, при очень ярком свете, оператор 
Screen приводит к полностью неправильным 
цветам. Таким образом, выбор оператора Mix или 
Screen полностью зависит от ситуации.

Теперь текстура выглядит довольно хорошо. Но 
все же она еще похожа на резину. Очевидно, отсут-
ствуют зеркальные отражения, поэтому приступим 
ко второй части.

Часть вторая. Добавление 
отражений

Шаг седьмой: Зеркальные отражения на двух 
слоях

Отражения, которые мы собираемся 
смоделировать, возникают по двум причинам: 
отражения от самой кожи (довольно мягкие и 
имеющие крупные размеры) и отражения от пота 
на коже, которые будут ярче и сильнее 
концентрированы. Оба отражения будут иметь 
голубоватый оттенок, чтоб уравновесить желтый 
цвет кожи. Лично я предпочел использовать 
стандартный шейдер Cook-Torrance для 
отражений, так как он, в отличие от шейдера 
Phong, позволяет получить что-то похожее на 
эффект Fresnel (отражения должны быть ярче под 
отстрым углом зрения).

Добавьте еще один шейдер в вашу модель и 
назовите его, напримет, «Skin_soft_speculars». 
Параметр Ref необходимо установить 0.00, 
поскольку диффузные отражения нам теперь не 

Эффект Fresnel часто упоминает-
ся, когда речь идет об отражающих 

поверхностях. Сила отражения большинства по-
верхностей при взгляде на них под острым углом 
отличается от силы отражения при взгляде под 
почти прямым углом. Этот эффект и называется 
эффектом Fresnel.

Пример такого эффекта вы можете увидеть, 
взглянув в окно: при взгляде на стекло под 
острым углом сложно что-либо разглядеть за 
окном, так как поверхность стекла становится 
сильно отражающей в отличие от случая, когда 
вы смотрите в окно обычным образом.

Замечание
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нужны. Цвет объекта 
можно сделать чистым 
черным.

Так же вы можете 
отключить кнопку Diff 
в редакторе нодов 
после добавления ва-
шего материала. Важ-
но, что эти шейдеры 
обеспечивают только 
зеркальные отраже-
ния. Для отражений 
используется шейдер 
Cook-Torrence. Пос-
кольку отражения для 
слоя кожи должны 
быть мягкими и иметь 
большую площадь, ус-
тановите значение 

Spec равным 0.1 и Hard равным 10.
Настроив светло-голубой оттенок для этого 

материала, вы можете добавить еще один матери-
ал, назвав его, например, «Sweat_hard_speculars». 
Его единственное отличие от предыдущего 
материала в том, что ползунок Spec установ-
лен в значение 0.3, а Hard — 30.

Шаг восьмой. Объединение зеркальных 
и диффузных отражений — конечное 
дерево нодов

Оба слоя зеркальных отражений теперь 
готовы. Выберите материал «Combined_sha-
ders» и снова откройте редактор нодов. До-
бавьте оба материала с картами отражений. 
Объедините оба материала оператором Mix 
(как обычно, Пробел > Add > Color > Mix и 
измените режим смешивания на Screen). 
Установите значение Faq равным 1.0. После 

оператора Mix можно добавить еще и контроллер 
RGB Curves, как это сделал я, для более быстрого 
контроля над яркостью отражений.

В довершение добавьте еще один оператор 
Screen, который наложит зеркальные отражения 
поверх диффузной части шейдера. Значение уров-
ня смешивания установите равным 1.0. На рисунке 
сверху показана часть дерева нодов, относящаяся 
к зеркальным отражениям материала, а на рисунке 
снизу показано полное дерево нодов материала.
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Теперь наш шейдер готов к применению. 

Конечно, есть несколько аспектов, которые могут 
быть и должны быть улучшены для достижения 
фотореализма. Если вам еще не стало скучно, то, 
возможно, вам захочется продолжить чтение. Часть 
третья ждет вас!

Часть третья: Двигаемся дальше
В этой части я попробую объяснить вам 

некоторое хитрости/приемы, знание которых 
позволит вам улучшить созданный шейдер, и, 
помимо этого, дам несколько советов по ренде-
рингу, которые помогут в достижении большего 
реализма.

1. Правильные блики с использованием 
мягких трассируемых отражений

Вы, вероятно, множество раз замечали, что 
зеркальные отражения — это не совсем удачный 
метод моделирования реального поведения света. 
В теории, блики возникают по причине объектов, 
имеющих яркость выше среднего уровня. Поэтому 
зеркальные отражения являются самым простым 
способом получения бликов. Они не могут отра-
жать ничего, кроме светлых объектов, и зеркаль-
ное отражение на поверхности не соответствует 
реальной форме отражаемого объекта (по крайней 
мере в Blender).

Взгляните на сравнительный рисунок и вы 
заметите, что, во-первых, зеркальные блики не 
отражают окружение (оранжевую плоскость и си-
ний фон). Далее, обратите внимание на странную 
форму зеркальных бликов при остром угле зрения. 
Они выглядят круглыми, в то время как должны 
иметь форму дуги как на рендере с мягкими отра-
жениями.

Что, если мы попробуем настроить блики, 
используя трассируемые отражения? Конечно, это 

будет накладно с точки зрения времени рендерин-
га. Но зато мы получим более удовлетворительный 
результат. Давайте попробуем. Все, что нужно 
сделать — добавить новый шейдер, который будет 
контролировать только мягкие отражения, и объе-
динить его с основным шейдером. Решение о пол-
ной или частичной замене зеркальных отражений я 
оставляю на ваше усмотрение, так как это сильно 
влияет на время рендеринга.

Во-первых, следует учесть, что поверхность не 
может быть полностью отражающей, поскольку мы 
хотим видеть только блики. Как будет выглядеть 
блик, если наш материал отражает только 50% 
света? Белый объект будет выглядеть белым только 
на 50%, если он отражается от поверхности с пя-
тидесятипроцентным отражением. Ответ прост: 
благодаря параметру Emit можно получить объек-
ты «белее белого». Настраивая этот параметр, мы 
получим правильные отражения на поверхности, 
которая плохо отражает свет. Взгляните на рендер, 
на котором показаны отражения трех плоскостей. 
Эти плоскости отличаются только значением Emit, 
которое увеличивается слева направо.А

вт
ор

: 
Vi

ct
or

 M
al

he
rb

e



Шейдер кожи с использованием многослойного SSS

www.blenderart.org Выпуск 16 | Май 2008 — Wow Factor

15
Если вы хотите использовать мягкие отражения 

вместо зеркальных бликов или, по крайней мере, 
объединить оба эти типа, то следует иметь ввиду, 
что источники света Lamp не образуют бликов. 

Поэтому вам 
придется до-
бавить допол-
нительные 
неподвижные 
объекты, ко-
торые могут 
отражаться, 
такие как 
сферы для 
имитации 
обычных 
ламп или пло-

скости для имитации зональных ламп. Можно даже 
использовать обезьянку или любой другой подходя-
щий объект.

Вам необходимо будет поместить эти объекты в 
том же самом месте и в том же самом положении, 
что и объект Lamp, но на другом слое (если вы 
поместите сферу точно в том же месте что и лампа 
со включенными тенями, то, конечно же, тень 
будет повсюду, поскольку свет не сможет выйти за 
пределы сферы).

Вместо объяснения деталей используемых 
настроек сцены я сделал скриншот тех значений, 
которые использовал в следующем рендере. 
Тридцать две выборки — это хороший компромис 
между временем рендеринга и качеством. Для 
финального рендеринга лучше использовать 64 
или 128 выборок. Более высокие значения 
приводят к такому незначительному уменьшению 
шума, что разницу сложно заметить.

Думаю, это все, что можно сказать о мягких 
отражениях. Теперь вам необходимо лишь доба-

вить новый шей-
дер в дерево 
шейдеров кожи 
и наложить его 
поверх диффуз-
ной части. Если 
хотите большего 
реализма, то 
можно использо-
вать два слоя 
мягких отраже-
ний для замены 
зеркальных от-
ражений. Это 
вполне логично, 
поскольку мы 
определили два 
вида зеркаль-
ных отражений в дереве нодов.

2. Совершенствуем шейдер далее

Шейдер, над которым мы работали, является 
«базовым» материалом, пригодным для большин-
ства случаев. И, конечно же, он может быть 
настроен в зависимости от того типа кожи, который 
вы хотите получить после рендеринга. Допустим, 
вы хотите получить «пушистую» кожу. Тогда ваш 
материал должен выглядеть мягко, с небольшим 
эффектом Fresnel, имитирующим бесчисленные 
волоски, которые становятся лучше различимы при 
взгляде под острым углом. Подобный эффект может 
быть получен настройками нодов Normal и 
Geometry в редакторе нодов материалов.

Или, если вам не хочется делать это нодами, 
можно использовать диффузный шейдер Minnaert 
вместо Oren-Nayar, который я использовал для 
нерассеивающего диффузного слоя. Эффекта 
«улучшения» краев также можно добиться исполь-А
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зованием мягких 
трассируемых 
теней с 
небольшим эф-
фектом Fresnel. 
Вы можете пого-
нять настройки 
материала по 
собственному 
вкусу: то, что я 
предложил — это 
всего лишь «ске-
лет», базовая за-
готовка, которую 
можно изменять 
и настраивать 
под собственные 
нужды.

Вот еще одна 
идея для иссле-

дования: составляя дерево нодов, мы ис-
пользовали фиксированные значения операторов 
смешивания, но ведь можно использовать текстуры 
для контроля параметра Fac. К примеру, значение 
оператора Screen между слоями дермы и эпи-
дермы равно 0.6, хотя в действительности оно не 
постоянно: на подошвах кожа кажется желтой из-
за более тостого слоя эпидермы; губы кажутся 
почти красными, так как слой эпидермы тонок в 
таких чувствительных местах, ну и так далее.

Ничто не мешает вам нарисовать текстуру, 
которая будет регулировать толщину слоя эпи-
дермы и затем вставить ее в дерево нодов для 
получения желаемого эффекта. Или можно исполь-
зовать красную текстуру с неравномерной яркос-
тью для имитации неравномерности толщины слоя 
эпидермы.

3. Тонкости рендеринга

В заключение приведу некоторые приемы рен-
деринга/постобработки, которые помогут усилить 
реализм отрендеренной кожи.

Перый трюк доволно простой: для увеличения 
яркости и контраста отрендеренного изображения 
вы можете использовать ноду наложения при пост-
обработке, с помощью которой наложить отрен-
деренное изображение на само себя. Цвета, 
контраст и т.д., естественно, могут быть под-
корректированы контроллером RGB Curves. Еще 
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бы я посоветовал использовать Ambient 
Occlusion! Кожа, конечно же, имеет свойство 
отсвечивать на саму себя. Чем ближе два участка 
друг к другу, тем более насыщенными (оранже-
выми в случае с кожей) они кажутся вследствие 
многочисленных отражений света между этими 
участвами. AO так же дает ощущение глубины 
отрендеренных полигонов. Вам лишь нужно на-
строить проход AO так, чтоб он был оранжевым, и 
затем умножить его на отрендеренное изобра-
жение, как показано на рисунке слева. Вы 
заметите, что, например, веки и губы лучше 
«прорисованы», если так можно сказать.

Заключение
В итоге мы получили вполне реалистичный 

шейдер, который, надеюсь, в дальнейшем поможет 
вам избавиться от обычно пластиково выглядящей 
кожи. Во-первых, я хотел бы поблагодарить 
сообщество Blender, от которго я получил много 
ценных советов. И, помимо прочего, спасибо вам за 
чтение. Все, что мне нужно вам пожелать — Happy 
Blending!

Ниже приведены несколько тестовых рендеров, 
показывающих что можно сделать с помощью 
шейдера. Постобработка не использовалась за 
исключением эффекта свечения.
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Стенфордский Будда и его друг, стенфордский дракон

А
вт

ор
: 

Vi
ct

or
 M

al
he

rb
e



Реалистичный дым в Blender

www.blenderart.org Выпуск 16 | Май 2008 — Wow Factor

19

Введение
Создание  реалистичного  ды-

ма,  как  и  любого  другого  атмо-
сферного  эффекта, является 
непростой  задачей.  Каждый  тип 
дыма  требует  различной  техни-
ки исполнения.  Если  вам 
необходимо  сымитировать  сига-
ретный  дым,  советую ознако-
миться  с  прекрасным  уроком 
Meltingman  в  этом  выпуске  жур-
нала.  Это действительно простой 
способ, который дает убедитель-
ный результат. Но если вам 
необходимо имитировать более гу-
стой дым, то нужно использовать 
другую технику исполнения. 

Конечно,  лучший  инструмент, 
которым  вы  можете воспользоваться, основан на 
симуляции жидкости для создания движения и 
элементов для рендеринга. Например, Lightwave 
снабжен мощным инструментом под названием 
«Hypervoxel» которым достигается этот тип 
обработки. Так как в Blender отсутствует данная 
возможность, а рендеринг движения частиц отнима-
ет много времени, нам придется выбрать другой 
способ. 

В течении нескольких лет CG художники, 
работающие в индустрии спецэффектов, использо-
вали системы частиц. Управление потоком частиц 
является не очень сложным, самое трудное — их 
визуализация. Как много частиц вам необходимо 
для создания реалистичного перемещения песка, 
похожего на сцену «Birth of Sandman» (Рождения 
песочного человека) в фильме Spiderman 3 
(Человек-паук–3)? Или другой пример. Вам прихо-
дится управлять миллиардами частиц, когда хочет-

ся имитировать снежную лавину. Как отрендерить 
каждую снежинку и сделать им правильные тени?

Для всех подобных типов эффектов, таких как: 
дым, смерч, водопад, песчаная буря, горящий 
метеорит, разрушение самолета, взрыв, и другие... 
Вы можете использовать прекрасный инструмент 
под названием «Sprites» или «Billboards» в Blender. 
Давайте посмотрим, как им пользоваться.

A) Создание эмиттера 
(излучатель) и текстур:

Шаг 1: Создайте но-
вую плоскость Add > 
Mesh > Plane, затем 
выйдите из режима 
редактирования (edit 
mode), при помощи 
клавиши Tab.

Шаг 2: Нажмите 
Alt+R и Alt+G, чтобы 
поместить плоскость в 
начало координат.
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Шаг 3: Нажмите 

клавишу N, чтобы 
показать плавающее 
меню «Transform Pro-
perties» (свойства 
трансформации). 
Установите значения 
Scale X, Y и Z (мас-
штаб по осям X, Y, Z) 
равными 0,725 и Loc 
X равное -4.

Шаг 4: Нажмите 
клавишу Tab, чтобы 
перейти в режим ре-
дактирования (edit 
mode) и нажмите кла-
вишу А для выбора 
всех вершин.

Шаг 5: Нажмите 
клавишу U и выбери-
те «Unwrap» чтобы 
сгенерировать UV-ко-
ординаты. Если эмит-
тер не имеет 
UV-координат, то рек-
ламные щиты 
(Billboards) не будут 
правильно отображе-
ны. Снова нажмите 
Tab, чтобы выйти из 
режима редактирования.

Шаг 6: В 
окне кнопок 
«Buttons 
Window» наж-
мите F5, что-
бы перейти в 
панель 
«Shading» 
(меню для 
настройки 
материалов), 
выберите пло-
скость и, клик-
нув «Add 
new» (добавить новый), назначьте плоскости 
новый материал.

Шаг 7: В меню 
материалов нажмите 
на «Shadeless» (бесте-
невой), чтобы сделать 
наш дым видимым, 
даже если в сцене нет 
освещения.

Шаг 8: Нажмите на 
кнопку «ZTransp» (про-
зрачность) для актива-
ции прозрачности без 
использования трасси-
ровки лучей и устано-
вите параметр А 
(«Alpha» — альфа) на 
0, чтобы использовать 
прозрачность текстур 
вместо глобального 
альфа («global» alpha).А
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Шаг 9: Нажмите 
F6 для перехода в 
панель текстур 
(«Textures»).

Шаг 10: Кликните 
на первой пустой 
кнопке и нажмите 
«Add New» (добавить 
новую).

Шаг 11: 
Установите тип 
текстуры на 
«Clouds» (обла-
ко) и установи-
те значения 
NoiseSize 
(размер шума) 
на 2, 
NoiseDepth (глубина шума) на 6 и переименуйте 
вашу текстуру в «Smoke_Color» (цвет дыма)

Шаг 12: 
Вновь кликните 
на пустой кноп-
ке, нажмите 
«Add New», 
выберите тип 
«Clouds», после 
чего выставьте 
NoiseSize на 
1,3 и NoiseDepth на 6. Переименуйте эту текстуру 
в «Smoke_Alpha» (альфа дыма).

Шаг 13: Перейди-
те в UV/Image 
editor (редактор 
UV/Image), чтобы на-
рисовать новую текс-
туру и создайте новое 
изображение Image 
> New.

Шаг 14: Установи-
те ширину Width и 
высоту Height на 512 
для определения раз-
мера новой текстуры 
и нажмите ОК.
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Шаг 15: Нажмите на кнопку «Enable Painting 

Texture» (включение рисования текстуры) в меню 
заголовка окна UV/Image editor, чтобы активизи-
ровать режим рисования «paint» и нажмите клави-
ши N и С, чтобы появились панели «Image Paint» 
(рисование изображения) и «Image Properties» 
(свойства изображения).

Шаг 16: Исполь-
зуйте инструменты 
рисования для созда-
ния произвольной 
формы рисунка бело-
го цвета, но только 
не пересекайте края 
изображения. Они 
должны остаться 
полностью черными. 
Пока вы рисуете изо-
бражение, можете 

нажать на кнопку «Airbrush» (аэрограф), чтобы 
рисовать непрерывно.

Шаг 17: Как только 
ваша текстура будет закон-
чена, переименуйте её в 
«Smoke_Mask» (маска ды-
ма) и нажмите на кнопку 
«Pack into blend» (упако-
вать в файл .blend). 
Blender задаст вам вопрос: 
«if you want to repack this 
texture as a PNG file…» (хотите ли вы упаковать эту 
текстуру как PNG файл…), просто согласитесь.

Шаг 18: Вернитесь в редактор материалов, 
используя клавишу F5.
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Шаг 19: Кликните 
на закладке «Texture» 
(текстура), выберите 
текстуру 
«Smoke_Color» и пере-
ключитесь в закладку 
«Map Input».

Шаг 20: Выберите кнопку «UV», затем перейди-
те в закладку «Map to» и выберите «Color». Если 
необходимо, то отключите все остальные кнопки.

Шаг 21: Кликните 
на кнопке пурпурного 
цвета и выберите 
белый цвет.

Шаг 22: Вернитесь 
в закладку «Texture» и выберите «Smoke_Alpha». В 
закладке «Map Input» выберите «UV», затем в 
закладке «Map to» выберите «Color» и «Alpha» 
(будьте осторожны в выборе «Alpha» – двойное 
нажатие инвертирует прозрачность).
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Шаг 23: Кликните 

на пурпурном цвете и 
выберите черный цвет.

Шаг 24: 
Вернитесь в закладку «Texture» и выберите 
«Smoke_Mask». В закладке «Map Input» выберите 
«UV» и в «Map to» выберите только «Alpha».

Шаг 25: Выберите 
пурпурный цвет, сде-
лайте его черным и 
измените «Mix» на 
Multiply.

B) Анимация потока частиц:
Шаг 01: Выберите 

объект излучения 
(здесь это плоскость) 
и нажмите несколько 
раз клавишу F7, пока 
не появится панель 
Particle (частиц).

Шаг 02: 
Кликните на 
кнопке «Add 
New» для соз-
дания нового 
потока, и на-
зовите его 
«Psys».

А
вт

ор
: 

Fr
an

ço
is

 G
ra

ss
ar

d



Реалистичный дым в Blender

www.blenderart.org Выпуск 16 | Май 2008 — Wow Factor

25

Шаг 03: В группе 
параметров «Initial 
Velocity» (начальная 
скорость), установите 
скорости Normal и 
Random равными 0.5.

Шаг 04: В группе 
параметров «Global 
effects» (глобальные 
эффекты) установите 
параметры ускорения 
по осям AccX равное 
7, AccZ равное 3 и 
Brown (броуновское 
движение) равное 15 
(эта функция реально 
полезна для 
нелинейного 
движения).

Шаг 05: Сейчас 
мы создадим новую 
камеру, потому что 
собираемся использо-
вать знаменитый тип 
частиц под название 
Billboard.

Шаг 06: В панели 
«Visualization» (наблю-
дения) установите тип 
частиц Billboard. 
Billboard также извес-
тный, как «Sprite», 
является простой пло-
скостью и всегда ото-
бражается в камере 
(именно поэтому мы 
предварительно созда-
ли камеру).

Шаг 07: Кликните 
по кнопке «Lock» что-
бы сохранить все 
биллборды параллель-
ными для избегания 
пересечения между 
ними.

Шаг 08: Установи-
те параметр Tilt (вели-
чина вращения, 
которая, кажется, вы-
ражается в радианах) 
на 0.015, а значение 
Rand — на 0.4, что 
дает при рождении 
каждому биллборду 
разный угол положе-
ния.
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Шаг 09: В заклад-
ке «Particle System» 
установите величину 
Amount (сумма) на 
300, End на 200 и 
Life на 75… или 
немного больше. Пока 
ваши биллборды не 
уйдут с экрана, когда 
вы смотрите на них 
через камеру.

Шаг 10: Сохрани-
те вашу сцену где-
нибудь на жестком 
диске. Я не шучу, это 
действительно важно!

Шаг 11: Кликните 
на закладке «Bake» 
(«запечь» в данном 
случае означает запи-
сать), находящейся 
рядом с Particle 
System и кликните 
на кнопке «Bake». 
Создастся новая ди-
ректория, в том же 
месте где сохранен .blend файл на жестком диске, 
(теперь вы поняли, почему это было важно?). 
Директория заполнится группой файлов (по одно-
му на каждый кадр) где сохранятся все данные о 
частицах.

Для вашего сведения: Как только ваши данные 
запишутся (или скешируются), вы все еще можете 
редактировать все параметры, которые не влияют 
на движение частиц (такие как: размер, цвет, 
прозрачность, потомок, …)

C) Анимация искривления и 
размера биллбордов:

Шаг 01: Сейчас, чтобы наш поток частиц был 
записан, выделите объект-эмиттер (здесь 
плоскость) и переключитесь в IPO редактор.
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Шаг 02: Кликните 

на выпадающем спис-
ке «Show IPO type» 
(показать тип IPO) и 
выберите «Particles» 
(частицы). Сейчас вы 
можете видеть различ-
ные параметры частиц 
в правой части редак-
тора.

Шаг 03: Кликните 
на «BBTilt» (наклон 
биллборда). Этот пара-
метр используется для 
вращения биллборда 
в соответствии с ви-
дом из камеры и воз-
раста частиц.

Шаг 04: Зажмите клавишу Ctrl и кликните 
левой клавишей мыши около нулевых координат 
(0/0), добавится новая точка.

Шаг 05: Еще раз создайте новую точку около 
200 кадра со значением 2.0

Шаг 06: Поверните касательные точек для 
имитации логарифмической кривой.
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Шаг 07: 

Кликните 
на парамет-
ре «Size» 
(размер) в 
правой час-
ти редакто-
ра IPO и 
создайте но-
вую точку в 
0/0 таким 
же путем 
как создава-
ли в пара-
метре «BBTilt».

Шаг 08: Добавьте около 200 кадра новую точку 
со значением 20. Оставьте базовую интерполяцию 
без изменений. Сейчас, если вы нажмете «Play», то 
сможете увидеть, как ваши биллборды вырастают 
и крутятся вдоль пути анимации.

Шаг 09: На-
жмите F12 для 
начала ренде-
ринга и увидите, 
что происходит. 
Да, перед нами 
густой и пыль-
ный дым!!!!

D) Повышение реалистичности с 
помощью составных материалов:

Шаг 01: Хорошо. Сейчас наш дым выглядит 
реалистично, но смотрится слишком плоским и 
необходимо добавить больше деталей и контраста. 
Таким образом, 
просто откроем 
«Node editor» (ре-
дактор узлов) и 
нажмем кнопки 
«Composite Nodes» 
(составной узел) и 
«Use nodes» 
(использовать уз-
лы).
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Шаг 02: Если у 
вас нет слоев 
визуализации 
(Render Layers), то 
добавьте один 
через Пробел > 
Add > Input > 
Render Layers.

Шаг 03: Создайте новый составной узел 
Пробел > Add > Output > Composite и нового 
«зрителя» Пробел > Add > Output > Viewer.

Шаг 04: Создайте новый узел смещения 
Пробел > Add > Distort > Displace и подключите 
выходной параметр «Image» узла «Render Layers» 
к входным параметрам «Image» и «Vector» узла 
«Displace».

Шаг 05: Установите параметры X Scale и Y 
Scale в узле «Displace» равными 20. Узел 
«Displace» используется для того, чтобы придать 
дыму движение, более похожее на жидкость.
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Шаг 06: 
Создайте новый 
фильтр Пробел 
> Add > Filter > 
Filter и установи-
те его в режим 
«Kirsch».

Шаг 07: Подключите выходной параметр 
«Image» узла «Render Layers» к входному «Image» 
узла «Kirsch».

Шаг 08: Установите параметр Fac узла «Kirsch» 
равным 1.0, если необходимо. «Kirsch» использует-

ся для ге-
нерации до-
полнительных
деталей, 
которые бу-
дут смешаны 
в оригиналь-
ной визуали-
зации.

Шаг 09: Создайте узел цветового смешивания 
Пробел > Add > Color > Mix, подключите выход-
ной параметр «Image» узла Displace к первому 
«Image» узла Mix.
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Шаг 10: Перетащите выходной параметр 

Image узла «Kirsch» на второй входной узла 
«Mix», установите параметр Fac в значение 0.15 и 
кликните по кнопке A («Alpha») узла «Mix».

Шаг 11: Создайте 
новый фильтр размывания 
Пробел > Add > Filter > 
Blur и установите парамет-
ры X и Y равные 2. Этот 
фильтр «Blur» позволяет 
дыму выглядеть мягким.

Шаг 12: Подключи-
те выходной параметр 
Image узла «Mix» к 
входному Image узла 
«Blur».

Шаг 13: До-
бавьте фильтр бли-
ков Пробел > 
Add > Filter > 
Glare. Установите 
в этом узле режим 
«Fog Glow» и 
подключите выход-
ной параметр узла 
«Blur» к единствен-
ному входному у 
«Glare».

Шаг 14: Установите значения параметров Mix 
равно 0.15, Threshold (порог) равное 0.40 и Size 
(размер) равное 9. Сейчас наш дым выглядит более 
контрастно, визуально увеличилась плотность.

Шаг 15: В завершение соедините выход «Glare» 
со входом Composite и «Viewer».А
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Шаг 16: В окне кнопок «Buttons Window» 

нажмите F10, чтобы перейти к установкам ренде-
ринга и кликните на «Do Composite».

Шаг 17: Выберите в окошке «output» путь к 
папке, где вы ходите сохранить ваши отрендерен-
ные кадры и нажмите «Anim», чтобы отрендерить 
анимацию.

Вывод
С помощью Billboards вы можете создать много 

прекрасных и реалистичных эффектов. Автоном-
ный компонент софта под названием «Particle 
Illusion» (http://www.wondertouch.com) является 
основанным на спрайтах (спрайт — элемент 
динамичного графического изображения) инстру-
ментом создания спецэффектов, который работает 
точно также как Billboard в Blender… только в 
реальном времени (Я очень жду всех разработок, 
созданных группой проекта Apricot, особенно под-
держки GLSL в 3D окне, которая сделает возмож-
ным наблюдать billboard в реальном времени с 
тенями и прозрачностью).

Посмотрите на этот невероятный инструмент… 
Несомненно он даст вам множество идей того, что 
становится возможным при помощи этой техноло-
гии. Следующим шагом является обеспечение 
Blender таким же типом библиотек доступных с 
«Particle Illusion», чтобы было легко создавать та-
кие эффекты, как дым, водопад или огонь, кото-
рые были бы доступны для любого эмиттера в 
сцене и могли бы импортироваться через File > 
Append or Link.

Создавайте свои собственные библиотеки 
и делитесь ими с другими: все эффекты частиц 
можно собрать на простом сайте, к примеру, на 
www.blender-materials.org и сделать доступным для 
всех. Вместе мы можем сделать это! Таким 
образом, поиграйте с billboard и частицами и удачи.
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Введение
В ходе урока вы сможете 

научиться основам создания дыма.

Часть 1 — последова-
тельность действий

Шаг 1: Сначала запустите 
Blender. Удалите куб, который 
присутствует в программе по умол-
чанию, затем добавьте Grid (сет-
ку) Пробел > Add > Mesh > Grid 
(32 x 32). И перейдите обратно в 
Object Mode (объектный режим): 
Tab.

Выберите сетку (Grid) и перей-
дите в режим Weight Paint (рисо-
вания распределения веса у 
вершин): Ctrl+Tab. При рисова-

нии на поверхности сетки сделайте только одну 
точку оранжево-красной, а все остальные окрасьте 
в цвета от желтого и до синего.

Используйте панель Paint (меню рисования), в 
панели редактирования Edit (F9). 

•  Mix, Add и Multi используются для смешива-
ния, добавления или умножения при Weight 
Paint; 

•  Sub — позволя-
ет вычитать неко-
торые вершины;

•  Blur — очень 
полезен для 
сглаживания 
Weight Paint.

Шаг 2: Добавление объ-
екта для искажения (deflec-
tor).

Deflector модифицирует 
активные объекты управле-
ния: частицы, мягкие тела и 
т.д.

Поместите Empty (Add > 
Empty), рядом с углом сет-
ки, где вес является самым 
большим (где самый крас-
ный участок).

Включите Deflection на 
Physics Button (F7), и 
затем установите: 

•  Wind (ветер) с 
небольшой силой 
Strength, в 
пределах от 0,02 
до 0,01;

•  включите Use 
Max Dist, и 
введите 
необходимую вам 
максимальную 
дистанцию. Это 
уменьшит влия-
ние ветра в выб-
ранных пределах.
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Шаг 3: Добавляем небольшую мягкость нашей 

сетке, благодаря специальным регулировкам в па-
нели Soft bodies (мягкое тело). Этим мы добиваем-
ся иллюзии мягкости и воздушности материала. 

Выберите сетку (Grid), далее перейдите на 
панель Object (F7), и затем — на панель Physics. 

Теперь переходим в Soft Body, и делаем следу-
ющие настройки:

•  Mass — 0 (или очень маленькое значение);

•  очень низкая скорость Speed — 0,09 (вы мо-
жете увеличить значение для предваритель-
ного просмотра, но для окончательного 
рендеринга лучше снизить);

•  выберите Use Goal > Group (для расчета 
будет взята Weight Paint);

•  выберите Use Edge и уменьшите его наполо-
вину (теперь ребра смогут растягиваться как 
надо для нашей симуляции).

Теперь несколько шагов для теста. 

Для просмотра предварительной анимации в 3d-
окне выбираем камеру (клавиша 0 на Numpad) и 
затем нажмаем Ctrl+A. Вы можите изменять мяг-
кость тела (soft body) или отклонение (deflection) 
для получения нужного результата.

Часть 2: воздушный материал
Сделаем наш дым совсем похожим на реальный 

с минимальным временем рендеринга. 

• добавляем нашей сетке материал; 

• переходим на панель Shading (F5), затем в 
меню Material,  Add New (добавить новый), 
затем посмотрим результат (F12) с 
существующими настройками. 

В меню Mirror Transp активируйте Ray 
Transparency и выставите:

• значение IOR в 1.0 (нет деформации во время 
преломления света)

• немного эффекта Fresnel, путем перемещения 
ползунка Fact на минимум его влияния

• уменьшите Gloss до 0, чтобы пропустить 
некоторые ненужные вычисления, а Samples 
выставьте в 1.0

• значение Depth должно находиться между 5 и 
10 (глубина прозрачности)А
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• в меню Material установите Alpha между 0.00 
и 0.25 

• открываем меню Ramps (обычно находится в 
меню Material) и нажимаем кнопку Show Col 
Ramp

• устанавливаем смешивание от белого до 
черного, выбрав Normal в меню Input > 
Ramps. Это даст эффект шелка. 

Здесь можно воспользоваться новыми возмож-
ностями. 

• Нажатая кнопка Map input > Stress изменит 
смешивание текстуры при деформации сетки. 

• Теперь добавьте Blend Texture в панели 
Texture (F6) > Add New > выберите Blend 
вместо None.

Возвращаемся в панель Material.
Добавляем для этой текстуры Map Input > 

Stress, Map To > Col и Map To > Alpha

Теперь все готово для финального рендеринга. 
Начать рендеринг можно следующим образом:

•  Переходим в меню Rendering (F10) 

•  выбираем формат получаемого файла 
(например AVI или QuickTime для видео) 

•  и наконец, нажимаем кнопку Anim для начала 
рендеринга
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Введение
На этом уроке вы увидите 

один простой метод получения 
меха для волка или аналогичных 
животных, пригодный для стати-
ческих изображений.

Шаг 1

Сначала попытайтесь найти 
какие-нибудь ссылки на изобра-
жения с передним, боковым и 
верхним видами головы волка в 
позе, подобной запланирован-
ной. Один из способов сделать 
голову — использовать моделиро-
вание из куба, модификатор 
Mirror (Зеркало) и модификатор 
Subsurf, установленный в 1. Как 
только вы будете удовлетворены 
основой модели, можете прило-

жить модификатор Subsurf, после которого вы мо-
жете сделать улучшающую коррекцию вашей 
модели.

Шаг 2

После маркировки ваших швов, сделайте UV-
развертку сетки (меша). Экспортируйте UV-развёрт-
ку в графический редактор (например GIMP, 
Photoshop и т.п.) и затем закрашивайте поверх 
развёртки в отдельных слоях. Это будет базовой 
кожей животного. Поскольку эта кожа находится 
под мехом, вам не нужно беспокоиться о точности.

Шаг 3

Найдите какие-нибудь изображения меха круп-
ным планом и настройте их в вашем графическом 
редакторе с помощью кисточек, фильтров и других 

инструментов. Эти изображения определят оттенок 
мехового цвета. Кроме того, точность не существен-
на; точка этого шага является основным цветом.

Шаг 4

Отделите нос, сделайте глаза и дублируйте меш.

Шаг 5

Поделите продублированный меш на отдельные 
части, где обозначено изменение меха и затем 
немного выдавите края (рёбра) на каждой меховой 
поверхности, чтобы покрыть соседнюю поверх-
ность. Это поможет смешиваться различным облас-
тям меха, чтобы они выглядели более естественно.

Шаг 6

Добавьте различные текстуры меха к каждой 
части и измените настройки частиц в соответствии 
с естественным окрасом меха. Для лучшего резуль-А
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тата, добавьте 
некоторое 
сферическое 
и vortex откло-
нение (deflec-
tion) для 
более естест-
венно выгля-
дящей формы 
меха. С реда-
ктором нодов 
вы можете 
приложить не-
который DOF* 
с эффектом Bokeh для фона, и затем поместить ва-
шего «домашнего животного» в его природную 
среду! 

Ниже показаны настройки частиц для волос, 
использованные для модели волка.

А справа — различные стадии разделения и 
модификации/подготовки меша для частиц.

* DOF — англ. Depth Of Field, глубина резкости. Область, в преде-
лах которой объекты отображаются четко.А
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Введение
Имитация океана является од-

ной из тех практических задач, 
над которой рано или поздно 
пытаются поработать все художни-
ки, занимающиеся компьютерной 
графикой. Для этого могут быть 
использованы различные техноло-
гии, в зависимости от того, каким 
программным обеспечением вы 
пользуетесь. Очевидно, что луч-
шим подходом для создания 
подобного эффекта является 
использование жидкости, но это 
потребует очень много времени. В 
сцене морского сражения в «Пира-
тах Карибского моря – 3» тысячи 
компьютеров в течение несколь-
ких недель проводили расчёты 

для того, чтобы смоделировать течение воды 
океана.

Другим методом моделирования движения океа-
на является использование «обычных» технологий, 
таких как модификаторы и ключевые кадры анима-
ции (keyframe). Здесь описан именно этот метод. 
Сосредоточимся на движении волн и временно 
забудем о шейдинге (из трёх предоставленных, два 
blend-файла содержат простой shading). И послед-
нее замечание. Все приведённые значения прибли-
зительны и могут быть уточнены. Всё зависит от 
размера вашего океана и, главное, от масштаба 
сцены в целом.

A) Готовим три основные 
текстуры:

Шаг 01:

Запустите Blender и 
создайте в нём новую сетку 
(Add > Mesh > Grid). Задайте 
параметрам X Res и Y Res 
значение 64 и нажмите ОК. 
Если Blender автоматически 
перейдет в режим редактиро-
вания (Edit mode), нажмите клавишу Tab чтобы 
вернуться в режим объектов (Object mode).

Шаг 02:

Поместите сетку в 
начало координат. Для 
этого нажмите Alt+R и 
затем Alt+G, чтобы 
сбросить значения пере-
мещения и вращения. 
Нажмите клавишу N, 
чтобы появилось меню 
«Transform Properties» 
(свойства трансформации), и установите Scale X, 
Y, Z (масштаб по осям X, Y, Z) на 6. Нажмите F6, 
чтобы перейти в панель «Texture» в «Buttons 
Window» (окно кнопок) и нажмите кнопку «World».
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Шаг 03:

Кликните на 
«Add New» что-
бы создать но-
вую текстуру. В 
поле «Texture 
Type» (тип текс-
туры) вместо 
«None» из списка 
выберите «Clouds». 
Установите зна-
чение шума 
Noise Size равное 0.5, Noise Depth (глубина 
шума) равное 6, а для Noise Basis (основа шума) 
выберите тип «Voronoi F2». Для того, чтобы потом 
можно было легко найти эту текстуру, измените её 
имя на «Turbulence» (турбулентность).

Шаг 04:

Щёлкните на пустой 
кнопке, расположенной 
ниже «Turbulence», сно-
ва нажмите на «Add 
New» (добавить новый) 
и выберите тип «Blend» 
(смешение). Выберите 
закладку «Color» (цвет), 
расположенную рядом с 
«Texture». Установите параметр яркости Bright на 
2 и контрастности Contrast на 0.01. Вернитесь на 
закладку «Texture» и дайте вашей текстуре имя 
«White».

Шаг 05:

Кликните на новой пустой кнопке, снова нажми-
те на «Add new» (добавить новый) и выберите тип 
текстуры «Clouds» (облака). Установите параметры 
Noise Size на 1.0 и Noise Depth на 0. Дайте этой 

текстуре имя «Bigwave» (бо-
льшая волна). Теперь у нас 
есть три основные текстуры 
для создания океана. Нажми-
те F9 для перехода в панель 
«Editing» (панель редактиро-
вания) и выберите сетку.

B) На старт, внимание, 
смещаемся!

Шаг 01:

Самое время ис-
пользовать три тексту-
ры, которые мы 
приготовили ранее. 
Для этого будем ис-
пользовать один очень 
мощный модификатор, 
который есть в Blen-
der — это Displace 
(смещение). Выберите нашу сетку, нажмите на 
кнопку «Add modifier» (добавить модификатор) и 
выберите «Displace» (смещение). Этот модифика-
тор предназначен для изменения формы меша в 
соответствии с яркостью любой текстуры. В пара-
метрах модификатора смещения установите в поле 
«Texture» текстуру «Turbulence» (ссылка на тексту-
ру, которую мы сделали раньше).

Шаг 02:

В параметрах модификатора смещения задайте 
параметру Midlevel (средний уровень) значение 
0.35, а параметру Strength (сила) значение 0.125, 
тем самым уменьшив эффект влияния. Для того А
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чтобы анимировать эти воз-
вышения, нам необходимо 
использовать объект, кото-
рый будет сообщать модифи-
катору смещения сдвиг 
между текстурой и сеткой. 
Для этого надо создать 
пустышку (Add > Empty), и 
затем нажать Alt+G и 
Alt+R, чтобы поместить его 
в центр координат.

Шаг 03:

Выделите пустышку 
(Empty) и нажмите F9, 
чтобы перейти в панель 
редактирования «Editing». 
Переименуйте пустышку в 
«Turbulence_1». Выберите 
сетку и проверьте парамет-
ры модификатора смещения (Displace) в панели 
редактирования «Editing». Нажмите на «Normal» и 
переключитесь на «Z», затем нажмите на «Local» и 
переключитесь на «Object».

Шаг 04:

Режим «Object» 
используется для 
добавления сдвига 
в смещение в зави-
симости от позиции 
другого объекта. В 
поле Ob: наберите 
«Turbulence_1», 
чтобы сослаться на 
созданную ранее 
пустышку. Если вы 
хотите проверить 

как работает смещение, попытайтесь подвигать эту 
пустышку.

Шаг 05:

Выберите пустышку и на-
жмите клавишу N, чтобы 
вызвать плавающее окно 
«Transform Properties». Уста-
новите ScaleX, Y и Z 
(масштаб по осям) в значе-
ние 6.3. Установите переме-
щение по осям LocX и LocY 
на 5 и установите значение 
LocZ на 0. Выберите сетку и затем кликните на 
кнопку «Set Smooth» (сделать гладким) в панели 
редактирования «Editing».

Шаг 06:

Создайте ещё одну 
пустышку (Empty), и 
назовите её 
«Turbulence_2». Помес-
тите её в центр коорди-
нат, используя Alt+R и 
Alt+G. Установите 
LocX, Y и Z в значе-
ния, соответственно, 
8.5, 6 и 3, а параметры 
Scale по всем осям — в значение 6.5. Выберите 
нашу сетку, затем вернитесь в панель редактирова-
ния «Editing» и нажмите кнопку «Copy» (копиро-
вать) в «Displace» для того, чтобы создать копию 
этого модификатора.

Шаг 07:

Измените значение силы Strength созданной 
копии модификатора «Displace» на 0.25 и введите в 
поле Ob: название «Turbulence_2». Теперь два А
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модификатора смещения 
«Displace» могут управлять-
ся независимо. Создайте 
новую пустышку (Empty) и 
поместите её в начало 
координат (Alt+R и Alt+G). 
Переименуйте её в «Waves» 
(волны), задайте парамет-
рам LocX, Y и Z значения 9, 
9 и 2, а три значения масштаба (scale) равными 4.5.

Шаг 08:

Выберите сетку и 
снова нажмите кнопку 
«Copy», расположенную 
ниже модификатора 
«Displace». Теперь у нас 
есть три модификатора 
смещения «Displace», 
которые применены к 
сетке. Два из них добав-
ляют небольшие колеба-
ния поверхности океана, а третий создаёт большие 
волны. В поле «Texture» задайте имя третьей 
текстуры «Bigwave» (большие волны), для того, 
чтобы сослаться на текстуру, которая была создана 
ранее. Установите значение Midlevel на 0.5, 
Strength на 0.4, а в поле Ob: введите «Waves», 
для того, чтобы сослаться на последнюю 
созданную пустышку.

Шаг 09:

Снова кликните по кнопке «Copy» внизу стека 
модификатора «Displace». Для параметров 
четвёртого «Displace» нажмите на «Z» и 
переключите на «Normal». Затем, нажмите на 
«Object» и переключите на «Local». Установите 
значение Strength равное 0.065 и введите в поле 

текстуры значение «White», ссылаясь на текстуру, 
созданную ранее. Этот четвёртый модификатор 
«Displace» используется для изменения высоты 
всех вершин в соответствии с собственными 
нормалями и для генерации гребней волны.

C) Анимация волн и добавление 
плавающего объекта:

Шаг 01:

Перейдите в пер-
вый кадр анимации, 
выделите пустышку 
«Turbulence_1» и наж-
мите на клавиатуре 
клавишу I для созда-
ния нового ключевого 
кадра анимации со 
свойствами «Loc» 
(«Loc» keyframe). 
Перейдите на 200 А
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кадр, передвиньте пустышку «Turbulence_1» на -6, 
-4, 0 с помощью плавающего окна «Transform 
Properties». Снова нажмите I и выберите «Loc» для 
того, чтобы создать второй ключевой кадр.

Шаг 02:

Теперь аналогично сделайте анимацию 
движения пустышки «Turbulence_2» в противопо-
ложном направлении, используя два ключевых 
кадра между 0 и 200 кадрами. Теперь движение 
двух пустышек, образующее букву «X», добавляет 
реалистичное волнение на поверхности моря. 
После этого сделайте анимацию движения пустыш-
ки с именем «Wave». Для того чтобы создать 
большие волны, она должна двигаться медленнее, 
чем две другие. Изменяя параметры скорости у 
разных пустышек, вы можете настраивать движе-
ние волн. Необходимо отметить, что по умолчанию 
базовым типом интерполяции у любого из анимиро-
ванных объектов является Безье. Однако, в нашем 

случае, лучше подходит линейная интерполяция. 
Тип интерполяции может быть установлен в редак-
торе IPO Curve Editor. Для этого необходимо выде-
лить все контрольные точки и нажать клавишу Т.

Шаг 03:

Теперь, когда мы 
создали движущийся 
океан, давайте доба-
вим на его поверх-
ность плавающий 
объект. Для этого 
воспользуемся функ-
циями, которые пре-
доставляет Blender. 
Добавьте в нашу 
сцену куб, нажмите 
Alt+R для сброса значения вращения в 0. 
Выделите куб, затем нажмите Shift и кликните на 
Grid, для того, чтобы добавить сетку к выделенным 
объектам.

Шаг 04:

Нажмите клавишу 
Tab, чтобы переклю-
читься в режим Edit 
mode. Выберите три 
вершины на сетке, 
формирующие равно-
сторонний треуголь-
ник. Чем больше 
треугольник, тем ме-
ньше волнение, кото-
рое передаётся кубу.
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Шаг 05:

Теперь нажмите 
Ctrl+P, затем выберите 
«Make Vertex Parent» 
(сделать вершины роди-
телями). Нажмите клави-
шу Tab, чтобы выйти из 
режима Edit mode. Те-
перь при помощи клави-
ши G переместите куб 
по поверхности таким 
образом, чтобы уменьшить размер пунктирной ли-
нии до 0. Как только всё будет готово, то нажмите 
«play» и наслаждайтесь.

Оптимизация для большой сцены
Как вы можете заметить, этот способ создания 

моря очень прост в настройке и даёт убедительные 
результаты. Модификатор смещения Displace в 
Blender является одним из моих любимых модифи-

каторов, посколь-
ку он работает 
очень быстро да-
же для моделей с 
тысячами полиго-
нов (по-моему, он 
самый быстрый 
из всех когда-
либо использован-
ных мной в 
других пакетах 
трёхмерной графики, которые я использую свыше 
15 лет).

Перед тем как закончить, я поделюсь с вами 
последней хитростью. Здесь мы имитировали 
только маленькую часть океана. Если вы хотите 
создать огромную поверхность с высоким уровнем 
детализации сетки, то рискуете убить компьютер 
ещё до момента нажатия кнопки «play».

В ходе работы вы можете динамически добавить 
или удалить разбиение (subdivision). Для этого 
просто добавьте модификатор Subsurf (сглажива-
ние) наверх стека в режиме «Simple Subdiv.». 
Таким образом, вы можете увеличивать или умень-
шать число разбиений, когда захотите. Когда вам 
необходимо настроить четвертый модификатор 
(тот, который генерирует гребни волн), просто 
увеличьте число уровней разбиения (subdiv 
number). После настройки модификатора, для нор-
мальной работы установите прежнее значение 
параметра. Вы даже можете установить два различ-
ных уровня разбиения — один для окна с трёхмер-
ным видом (3D view), а другой для рендеринга.

Если вы хотите протестировать последнюю SVN 
версию Blender с «Adaptive Subdivision» патчем, то 
скачайте её на graphicall.org. В ней вы можете 
динамически уменьшать число полигонов согласно 
расстоянию до камеры.А
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Дальние части вашего океана не будут иметь 

достаточного уровня разбиения для того, чтобы 
воспроизвести небольшие волнения на поверхнос-
ти (но нам это безразлично, поскольку они распо-
ложены далеко и их не видно). Однако большие 
значения смещения «Big_Waves» на них всё же 
действуют, и число полигонов для расчёта вашим 
компьютером значительно уменьшится.

Так что вы можете создавать бесконечный 
океан без большого числа полигонов. Удачи, 
мальчики и девочки.
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Введение
Создание реалистичного огня бы-

ло одним из самых больших вызовов 
в моей жизни CG художника. За мно-
го лет я пробовал разные техники 
для симуляции подобного эффекта. 
После использования простых ани-
мированных объектов с похожими 
шейдерами, частиц, спрайтов, жид-
кости, и даже метаболов со 
специальными настройками компози-
ции (наподобие того, что использо-
валось в Шреке), я наконец изобрел 
метод создания идеального анимиро-
ванного огня. 

Для начала, я должен сказать 
что данная техника придумана не 

мной. Первым, кто показал мне этот метод был 
великий Алан Мак Кей (Alan McKay), один из 
лучших художников частиц. Последний год я писал 
уроки для французской редакции «Computer Arts» 
про Ghost Rider и как симулировать огонь в 3ds 
Max и особенно в Particle Flow. Я пересмотрел все 
видео Алана, включающие одно, которое показыва-
ло как создать огонь, используя Pflow. 

Анимация огня была достаточно реалистичной, 
но рендер все еще выглядел достаточно искус-
ственно. Я взял мой рендер, загрузил его в After 
Effects и попытался подкорректировать его и доба-
вить несколько эффектов. Наконец, я добился 
своего и создал самый реальный огонь из тех, что 
когда либо делал. Когда я дописал мой урок для 
журнала, я открыл для себя первую сборку патча 
для частиц Джакха (Jakha) на Graphicall.org. Я 
прочитал все логи и был действительно удивлен 
всеми возможностями патча. Все что нужно было 
для такого же эффекта это только Блендер, 

который является законченным инструментом для 
композиции, включающий различные эффекты (в 
частности Векторное размытие и Ноды Смещения). 

Ради шутки, за несколько ночей проведенных 
только за Блендером я полностью выбился из 
сил — все это я раньше я делал в 3ds Max и After 
Effects. Это один из множества примеров которые 
показывают что Блендер может быть использован 
для создания всех видов эффектов. Что ж, готовы к 
поджогу? Поехали!!!

А) Создаем эмиттер и группу 
вершин:

Шаг 01:

Для начала, нам 
нужен обьект для 
поджога. Добавим 
новый примитив в 
нашу сцену, напри-
мер Сюзанну (Обезь-
янку).

Шаг 02:

Переключитесь в 
Edit mode, исполь-
зуя клавишу Tab, и 
снимите выделение 
со всех вершин кла-
вишей А.А
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Шаг 03:

Нажмите Пробел и 
выберите Select > Ran-
dom.

Шаг 04:

Поставьте параметр 
Random 40% и нажмите 
«OK». Будут случайно выде-
лены некоторые вершины.

Шаг 05:

Теперь, когда ваши вер-
шины выделены, вы должны 
создать новую группу вер-
шин (Vertex Group). Для это-
го, нажмите F9, чтобы 
перейти к параметрам редак-
тирования (Editing), и на па-
нели Link and Materials нажмите кнопку «New» 
для того, чтобы создать новую группу вершин. 
Назовите ее «Emivert» а затем нажмите «Assign», 
которая находится ниже кнопки «New».

Шаг 06:

Нажмите клавишу Tab 
чтобы выйти из режима ре-
дактирования, выделите Сю-
занну, и нажмите Shift+O 
чтобы добавить модифика-
тор Subsurf.

Шаг 07:

Оставьте выделенным 
меш Сюзанны и нажмите F7 
несколько раз, пока вы не 
окажетесь на панели частиц 
(particle). Нажмите «Add 
New» для того, чтобы доба-
вить новую систему частиц 
(a.k.a. «Psys») к вашему объекту.

Шаг 08:

Сейчас вам нужно сохранить сцену где-нибудь 
на жестком диске, потому что Blender создаст но-
вую директорию для кеша системы частиц там, где 
находится ваш файл .blend

Шаг 09:

Оставьте выделенным меш 
Сюзанны и перейдите на па-
нель «Physics». Установите 
Random равный 0.5, AccZ = 
8.0 и Brown = 5.0. частицы А
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идут вверх и некоторые из них случайно дрожат в 
соответствии со значением Brown.

Шаг 10:

На панели «Particle 
System», настройте значение 
Amount = 3500, End = 150 и 
Life = 25. В «Emit From», 
отметьте «Random» и «Even» 
и переключите с «Jittered» на 
«Random».

Шаг 11:

На панели «Extras», 
откройте выпадающее меню 
«Neg» в разделе «Vertex gro-
up» и выберите группу 
«Emivert», которую вы ранее 
создали. Сейчас частицы бу-
дут испускаться только из тех 
вершин, которые находятся в 
этой группе вершин!

Шаг 12:

Перейдите на панель 
«Bake», которая находит-
ся рядом с панелью 
«Particle System». Выставь-
те параметр End = 150 и 
нажмите «Bake». Blender 
создаст новую директо-
рию, там же где и ваш 
.blend файл на жестком 
диске и заполнит ее пакетами файлов (один для 
каждого кадра анимации). Вся кешированная ин-
формация будет храниться здесь.

B) Генерируем связку сфер:

Шаг 01:

Содайте новую Ico-
sphere и поставьте пара-
метр Subdivision равный 
3, затем нажмите клавишу 
Tab для того, чтобы выйти 
из режима редактирова-
ния, после чего нажмите 
Alt+R и Alt+G, чтобы 
сбросить параметры вра-
щения и расположения. Разместите Icosphere в 
центре координат мира (world coordinates).

Шаг 02:

Анимируем размер сферы во времени. Создадим 
первый ключевой кадр в кадре 1 и ставим Scale по 
координатам X, Y и Z почти равным нулю. В кадре 
10, создайте новый ключевой кадр и поставьте все 
три параметра равными 0.2. В конце создадим по-
следний ключевой кадр в 30 и поставим параметр 
Scale равным нулю. Потяните касательную кривой 
(в редакторе Ipo Curve), чтобы создать что-то 
наподобие параболы.
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Шаг 03:

Выделите Icosphere и добавте к ней новый 
шейдер. На панели материалов, поставьте Col 
(цвет) равный Hex-коду D77503, и Spe (зеркаль-
ность), равную F7F69B. Поставьте A (прозрач-
ность) равную 0.2 и нажмите кнопку «ZTransp» (на 
панели «Links and Pipeline») для того, чтобы акти-
визировать прозрачность без трассировки лучей.

Шаг 04:

На панели «Sha-
ders», поставьте 
Spec равное 2.0 и 
Hard равное 200. 
Не активируйте 
Raytracing (ни 
«Ray Mirror»,  ни 
«Ray Transp»), пото-
му что время ренде-

ра может быть очень большим и параметр Depth 
никогда не будет высоким для получения достаточ-
но хорошего результата.

Шаг 05:

Выделите ваш 
излучатель час-
тиц (Сюзанну) и 
в параметрах час-
тиц перейдите на 
панель «Visualiza-
tion». Нажмите 
на «Point» и 
измените ее на 
«Object». В поле 
OB: наберите «Sphere», соответствующую ани-
мированной икосфере. Нажмите на «Emitter», для 
того чтобы меш Сюзанны тоже визуализировался.

Шаг 06:

Выделите Сю-
занну и добавьте к 
ней новый шейдер, 
выберите черный 
цвет рассеивания 
(diffuse color) и 
нажмите кнопку 
«Shadeless». Это 
поможет визуали-
зировать очерта-
ния излучателя 
так, как будто 
огонь вычитается из него.А
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Шаг 07:

Нажмите F6 несколько раз для того, чтобы 
перейти на панель «Texture buttons», нажмите 
«World», затем «Add New», и выберите тип 
текстуры — «Clouds». Оставьте все параметры по 
умолчанию и назовите ее «Turbulence».

Шаг 08:

Добавте новый 
объект Empty к на-
шей сцене (Пробел 
> Add > Empty), 
выделите его и наж-
мите F7 несколько 
раз, чтобы перейти к 
панели «Physics». На 
панели «Fields», в 
выпадающем списке 
выберите «Texture» 
и введите «Turbulence» в поле «Texture». Переклю-
чите «RGB» на «Gradient» и поставьте Strength 
равное 1.0.

Шаг 09:

Выделите Сюзан-
ну, нажмите Ctrl+B 
и выберите «Free 
bake selected» за-
тем снова Ctrl+B и 
«Bake selected» что-
бы удалить и снова 
создать кеш (после 
того как мы только 
что вписали новое 
поле «Texture»).

Шаг 10:

Добавьте камеру 
и лампу к вашей 
сцене и поставьте 
энергию лампы рав-
ную 3, затем пере-
двиньте ее вперед в 
зону выше и правее 
вашей системы час-
тиц, между частица-
ми и камерой.

Шаг 11:

Добавьте новую 
решетку Lattice к 
вашей сцене, и пос-
тавьте параметры U 
и V равные 2, а 
параметр W равный 
5.
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Шаг 12:

Используя клавишу Tab перейдите в режим 
редактирования (Edit mode) и выделите все конт-
рольные точки Lattice, используя клавишу A. Соз-
дайте новую группу вершин, назовите ее 
«Lattice_Points» и нажмите «Assign».

Шаг 13:

Выйдите из ре-
жима редактирова-
ния, выделите 
Сюзанну и добавь-
те к ней новый 
модификатор Latti-
ce. Введите имя 
вашей решетки 
(lattice) в поле 
«OB:» и в поле 
«VGroup» введите «Lattice_Points», чтобы смещать 
только частицы, а не излучающий меш.

Шаг 14:

Выделите решетку, пе-
реключитесь в режим реда-
ктирования и переместите 
верхние точки в связку, 
после чего из вида сверху 
немного перекрутите точки 
(чтобы пламя имело закру-

ченный вид — прим. пер.). Когда это сделано, по-
киньте режим редактирования и нажмите «Play», 
используя Alt+A, чтобы посмотреть вашу анима-
цию.

C) Рендеринг и композиция:

Шаг 01:

Сейчас, когда настроена анимация вашего огня, 
мы должны добавить финальный магический 
штрих, используя инструменты композиции. Нажми-
те F10 в «Buttons window», чтобы перейти к 
параметрам рендера. Перейдите на панель «Render 
Layers» и нажмите кнопку «Vec».
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Шаг 02:

Откройте редактор нодов (Node Editor), 
выберите «Composite Nodes» и «Use nodes». Здесь 
должны быть нод Render Layers и нод 
Composite. Если их нет, добавьте их, используя 
Add > Input > Render Layers и Add > Output > 
Composite.

Шаг 03:

Для следующе-
го нода исполь-
зуйте Add > 
Filter > Vector 
Blur, и соедините 
выходы Image, Z 
и Speed нода 
Render Layer с 
такими же входа-

ми нода Vector Blur. Нажмите кнопку «Do 
Composite» на панели «Anim», и запустите рендер, 
используя F12, чтобы увидеть текущую компози-
цию. Только с этой настройкой, мы уже превратили 
наши сгустки сфер в неплохой огонь.

Шаг 04:

Далее используйте Add > Distort > Scale и 
подключите выход Image нода Vector Blur к 
такому же входу нода Scale, затем сделайте 
параметры X и Y равными 1.05.

Шаг 05:

Добавьте нод Vector > Map Value, настройте 
параметр Offs равный 0.50 и соедините выход 
Image нода Scale со входом Value нода Map 
Value.
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Шаг 06:

Добавьте нод 
Distort > Dis-
place и настрой-
те X Scale и Y 
Scale равными -
10. Подключите 
выход нода Map 
Value к входу 
Vector нода Dis-
place, а потом 
выход Image 
нода Vector 
Blur к входу Image нода Displace.

Шаг 07:

Добавьте нод Converter > ColorRamp и пере-
двиньте черный маркер вправо, где-то на 60% по-
зиции градиента. Подключите выход нода Displace 
к входу Fac нода ColorRamp.

Шаг 08:

Добавьте нод Color > Mix, переключитесь с 
режима «Mix» на «Add». Установите параметр Fac, 
равный 1.0, и подключите выход нода Displace к 
первому входу Image нода Аdd и выход 
ColorRamp ко второму входу Image.

Шаг 09:

Дублируйте нод Add, используя Shift+D, и 
установите Fac дублируемого нода 2.0. Добавьте 
нод Filter > Blur, измените режим с «Flat» на 
«Gauss», а затем настройте X и Y равные 20. 
Подключите выход Image нода ColorRamp ко 
входу Image нода Blur. Подключите выход нода 
Blur ко второму входу Image нашего дублирован-
ного нода Add, соедините выход оригинального А
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нода Add с первым входом Image дублированного 
нода Add.

Шаг 10:

Добавьте нод Color > RGB Curves, подключите 
выход нода Add к входу Image нода RGB Curves. 
Добавьте две точки к кривой «C», измените 
профиль с mimic на exponential curve.

Шаг 11:

Добавьте другой 
нод Filter > Blur и 
измените режим с 
«Flat» на «Gauss», а 
параметры X и Y сде-
лайте равными 40. 
Добавте новый нод 
Color > Mix, пере-
ключитесь в режим 
«Add» и установите 
Fac 1.0. Соедините выход RGB Curves со входом 
Image нашего нового нода Blur и с первым входом 
Image нового нода Add. В конце соедините выход 
Blur со вторым входом Image нода Add.

Шаг 12:

Наконец, добавьте нод Output > Viewer и 
соедините выход последнего нода Add со входами 
Image только что созданного нода Viewer, и 
оригинального нода Composite.
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Шаг 13:

В «Buttons window», 
нажмите F10, чтобы пе-
рейти к настройкам рен-
дера. Выберите 
желаемый формат (фор-
мат файла, компрессию 
и размещение) для ваше-
го видео, запустите рен-
дер для всех кадров вашей анимации, нажав 
кнопку «Anim» или Ctrl+F12.

Нет дыма без огня:
Используя новую систему частиц Блендера 2.46 

(особенно «Reactor», который может генерировать 
систему частиц во время смерти другой), вы може-
те комбинировать этот урок про огонь с уроком про 
симуляцию дыма.

В ближайшем будущем в Блендер будет восста-
новлена прекрасная возможность (ранее интегри-
рованная, но устаревшая в связи с проектом 
Peach), что сделает возможным редактирование 
всех типов частиц, а не только волос/меха 
(hair/fur). С этой возможностью вы сможете лепить 
контур вашего огня без использования решеток 
(lattice), как мы делали здесь.

Будущее системы частиц выглядит многообеща-
юще, и Блендер не будет пристыженным своими 
возможностями при сравнении с другим ПО.
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Введение
Эта сцена требует генера-

ции движения тысяч обьектов 
очень особенным способом, 
основная идея была — выстро-
ить беседку (gazebo) из ма-
леньких частей, падающих с 
неба. Так как анимирование 
всех этих обьектов вручную — 
не самый лучший и гибкий 
метод, мы решили создать 
скрипт на Python, который мог 
бы обработать движение каж-
дой из частей, основываясь на 
конечной желаемой позиции.

Завершенный скрипт дви-
жения можно найти здесь: 
http://pasteall.org/174.

Основные вычисления
Мой подход состоит из двух простых и предска-

зуемых алгоритмов, один из которых управляет 
падением (ось Z), а другой контролирует переме-
щения (translations) (оси X и Y) объекта. Для 
движения по Z я пользуюсь формулой свободного 
падения, которую мы все изучали в школе: (Вики-
педия и Google это замечательные инструменты 
для тех, у кого плохо с памятью/математическими 
способностями, как у меня):

z = (- 0.5 * Gravity * Time ** 2) + 
(Initial_Velocity * Time) + Initial_Altitude

Вы можете увидеть соответствующую функцию 
в 87-й строке скрипта. Таким образом, использова-
ние формулы свободного падения даёт мне хоро-
шие правдоподобные значения Z Loc с которых 

можно начать; теперь для части перемещения 
(translation part) используем простую формулу двух-
мерной линейной экстраполяции, работающую при-
мерно так: 

a = 2
b = 10

Сначала найдём разность между a и b с помо-
щью вычитания

b - a = 8

Теперь разделим эту разность на какое-нибудь 
большое число, допустим, на 100

8 / 100 = 0.08

Это даёт нам 100 равномерно распределённых 
шагов между позициями a и b. Например, если мы 
хотим найти срединную позицию, мы делаем так:

0.08 * 50 = 4

И смещаем это значение относительно a 

4 + a = 6

То же самое можно сделать для любого другого 
значения от 0 до 100: 

(b - a) / 100 * 85 + a = 8.8

Из этого следует ещё вот что: мы можем исполь-
зовать значения больше 100, чтобы сделать экстра-
поляцию. Возьмём, к примеру, 175: 

(b - a) / 100 * 175 + a = 16

В скрипте я пользуюсь этим для получения зна-
чений X Loc и Y Loc каждого объекта исходя из их 
желаемого конечного положения (b) и центра 
беседки (a), взятых мной из пустого объекта, так 
что я могу анимировать их с колебательными дви-А
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жениями для получения интересных эффектов, см. 
строки 68 и 78 в окончательной реализации.

Добавление отклонений:
Python поставляется с модулем «random», кото-

рый хорош для лёгкого добавления отклонений к 
результатам каждого запуска формул. На самом 
деле он даёт не случайные, а псевдослучайные 
числа, это значит, что он берёт заданное иницииру-
ющее число (seed number) и на его основе генери-
рует много чисел и, если позднее вы дадите ему то 
же инициирующее число, то он сгенерирует те же 
самые числа. Это хорошая характеристика, пос-
кольку она позволяет нам сохранять вещи полнос-
тью предсказуемыми, как я упомянул ранее. 

Если вы вернётесь к функциям Loc и Rot, то 
увидите как сгенерированные случайные числа ис-
пользуются для добавления отклонений к результа-
там. Строка 39 показывает как задать разные 
инициирующие числа для каждого объекта, остаю-
щиеся постоянными во времени, избегая дрожания 
в движении объекта.

Доводка
Прежде чем запустить главный скрипт я сохра-

нил исходные положения (rest positions) в свойст-
вах старого доброго Game-Engine, используя на 
этот раз другой скрипт (http://pasteall.org/251). Он 
также сохраняет значение смещения начального 
времени (starting time offset value) для каждого 
объекта. Пример, которым я делюсь, был здесь 
использован для крыши; он устанавливает старто-
вое время в соответствии с расстоянием от центра 
по формуле, которую вы можете видеть в строке 
38 и именно поэтому черепица крыши начинает 
падать в положения начиная от внешней кромки к 
центру. Я также немного использую здесь генерато-

ры случайных чисел. Таким образом, скрипт исполь-
зует много случайных чисел и разных формул, и 
нам по-прежнему нужно контролировать конечное 
или начальное положение каждого объекта так, 
чтобы вся совокупность их корректно строила 
беседку; в нашем случае предсказуемые формулы 
и генераторы псевдослучайных чисел спасают 
положение. 

Фокус состоит в предсказании того, где объект 
должен оказаться в конце движения и скорректиро-
вать текущее движение таким образом, чтобы объ-
ект в действительности достиг того положения, где 
вы хотели бы его видеть. В строках 96-98 и 113-
115 я вызываю формулы смещения и поворота 
(location and rotation), но скармливаю им значение 
времени 100, соответствующее концу движения 
(что-то вроде заглядывания в будущее!). Далее в 
строках 130-135 я просто вычитаю это значение из А
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результатов формул реального времени — и все 
объекты волшебным образом правильно приземля-
ются в центре мира. Под конец я добавляю значе-
ния расположения (location values), ранее 
сохранённые в каждом объекте с помощью вторич-
ного скрипта и теперь они приземляются в желае-
мой позиции!

Сглаживание движения:
Формулы, используемые в данный момент, 

особенно экстраполирующий перенос, возвращают 
линейное перемещение, которое производит очень 
механистичное движение. Однако, оно выглядит 

лучше, когда прямо перед тем, как каждый кусочек 
достигает своей позиции, происходит некоторое 
замедление. Это то, с чем лучше всего справляются 
кривые IPO, так что я пользуюсь ими для 
управления временным промежутком всех формул. 
Посмотрите в строке 52 функцию, берущую 
текущее значение из кривой с простым именем 
«IPO» и, если вы проверите возвращаемые 
значения всех функций вращения и перемещения, 
то увидите как это значение используется там для 
преобразования линейного временного интервала. 

Теперь, когда вы понимаете, как это работает, 
можете сами попробовать, следуя этим инструкци-
ям: 

1. Добавьте к объектам свойства игрового движ-
ка (game engine), где будут сохраняться их ис-
ходное положение (rest location) и смещение 
стартового времени; это делается вторым 
скриптом , обрабатывающим выбранные объек-
ты. Свойство Start присваивается разными 
формулами, которые вы напишете для разных 
особых случаев. 

2. Добавьте ваши объекты в группу «Main», ког-
да вы захотите прекратить их анимацию прос-
то удалите объекты из этой группы. 

3. Добавьте основной скрипт как ScriptLink, за-
пускающийся от «FrameChange», и продирай-
тесь сквозь фреймы! 

4. Вам нужна кривая «Time» в объекте Empty на 
IPO с простым названием «IPO», идущая от (0, 
0) до (100, 10); она управляет интерполяцией 
каждого куска, так что вы можете добавить эф-
фект «замедления» и т.д. 

5. Вам нужен ещё один объект Empty с названи-
ем «Center» в центре сцены или в центре эф-А
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фекта строительства, вы можете анимировать 
этот объект для получения красивых колебате-
льных движений. 

6. Запустите анимацию с помощью Alt+A или 
timeline.

Credits:
Wow Factor создан martestudio.com 
Отрендерил Oliver «imshadi» Zúñiga 
Особая благодарность Joshua «aligorith» Leung и 

Geoffrey «briggs» Bantle за инструменты 
разработки, необходимые для завершения этого 
ролика. contact@zanqdo.com

Вы можете просмотреть финальную версию 
ролика здесь: http://zanqdo.com/tmp/Rancho.mov 
(Пожалуйста, не ссылайтесь напрямую).
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Введение
Когда Сандра Гилберт (Sandra 

Gilbert) связалась со мной в апреле, 
чтобы написать статью о моём корот-
ком фильме «Tape-a-l’oeil» для журна-
ла BlenderArt, моей первой реакцией 
было ощущение радостной неожидан-
ности. Я немедленно принялся раз-
мышлять о том, как хорошо было бы 
вернуться к этой работе и дать предс-
тавление о ней всем остальным, 
делающим подобное. После некоторых 
размышлений стало очевидно, что я 
не использовал никаких особых приё-
мов или скрытых особенностей Blender.

Мой короткий фильм был минима-
листичен во многих отношениях, не 
исключая инструментарий, использо-

ванный мною для его создания. Я подумал ещё 
немного и меня осенила идея для статьи. Почему я 
должен писать статью об использованных инстру-
ментах и приёмах, которые, скорее всего, уже 
рассмотрены не менее чем в дюжине других 
уроков, когда вместо этого я могу написать статью 
об опыте, полученном во время этого проекта. 
Чему я научился, так это тому, что ограничения 
замечательно помогают воображению. В этой 
статье я попробую углубиться в свой процесс 
производства (production) и показать как удалось 
выполнить работу в срок.

Прежде всего, ребята, вам нужно посмотреть 
этот фильм, если вы этого ещё не сделали. Его 
можно увидеть на нашем недавно открытом сайте. 
Если сейчас спрашиваете себя «а это, случайно, не 
сайт Джонатана Вильямсона (Jonathan Williamson), 
a.k.a Mr_bomb на Blenderartists.org?», убедитесь, 
что читали блог и всё понимаете. Все остальные — 

читайте дальше! Оказавшись на сайте, пройдите в 
галерею, потом — в её раздел анимации.

Теперь, когда вы просмотрели его, я объясню 
вам, в каком контексте делался этот короткий 
фильм. Это был дипломный проект (thesis project) 
по итогам моего двухлетнего изучения кинематогра-
фии в колледже. Данная нам тема называлась «Я и 
кино» («The cinema and myself») и только я сделал 
по ней анимационный фильм.

И именно это было источником основных моих 
проблем. Было поставлено три условия: продолжи-
тельность фильма должна быть от 3 до 5 минут, 
съёмка должна длиться не более двух дней и 
монтажные (editing rooms) занимать не дольше 25 
часов. К счастью для меня, мой преподаватель 
освободил меня от двух последних.

Это дало мне целых два месяца, февраль и 
март, и 8 дней в апреле для моделирования, 
текстурирования, анимации, рендеринга, написа-
ния музыки и монтирования фильма в целом. Всё, 
что могло пойти неправильно, пошло неправильно, 
и 1-го февраля я принял вызов из исследовательс-
кой группы (research team), попросившей меня 
создать двухминутную анимацию.

Короче говоря, я согласился, и это дало мне 
полный месяц, чтобы это закончить. Я официально 
начал работу над моей короткометражкой 3-го 
марта. Сейчас вы, возможно, спрашиваете себя — 
зачем я рассказываю все эти вещи? Хочу ответить, 
что эти заметки о создании фильма, показывают, 
что моя жизнь в этот период времени в основном 
была занята этим фильмом. Итак, моя основная 
проблема была ясна: как создать пятиминутную 
жемчужину анимации в такой маленький 
промежуток времени.

Первое, что я сделал, это сократил сценарий. Я 
выкинул некоторые кадры, единственное достоинст-
во которых было в их крутизне, что помогло мне А
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улучшить свои первоначальные намерения, и 
позднее дало возможность изменить название на 
«Tape-a-l’oeil», что переводится как «красивость» 
(«eye-candy»). Далее я начал разбивать сценарий 
на отдельные «сцены» и разделы. Так как я не 
слишком хорошо рисую и не имел свободного 
времени, то никаких раскадровок я не рисовал 
(хотя вам они, определённо, понадобятся, если вы 
планируете делать короткометражку), но я доста-
точно хорошо представлял сценарий, чтобы точно 
знать, как представлять тот или иной эпизод. Я 
начал с создания серии папок, представляющих 
каждую сцену. Вы можете увидеть моё дерево 
папок на рисунке 1.

Моя папка «Pre-prod» была заполнена 
сценарием (-ями), а также вдохновляющими 
материалами (inspirational pieces). Я всегда храню 
вдохновители и обращаюсь к этой папке всякий 
раз, когда начинаю сомневаться, выражает ли 
определённый кадр те чувства, которые мне бы 
хотелось. Это могут быть песни, картинки или 
тексты — я сохраняю в этой папке всё, что 
вдохновляет меня на создание этого фильма. В 
папке «Prod» я храню все файлы, которые создал в 
процессе разработки.

Сначала я создал папку для моделей и текстур. 
Все модели, используемые от сцены к сцене (в 

данном случае лампочка и персонаж), были 
сохранены в этой папке, так что я мог в любой 
момент добавить и прилинковать их к той или иной 
сцене. Употребление текстур было минимальным, в 
этом фильме их часто вообще не было, так что 
часть папки оставалась пустой. После этого я 
создал две главные папки для работы (production).

Мне понадобилось сделать это именно таким 
образом по определённым причинам. Перво-напер-
во, мой рассказ о двойственности между техничес-
кой стороной кино и анимации и теми далёкими от 
артистизма вещами, которые должны быть сделаны 
для создания фильма, а также об эмоциях и 
креативности, возникающих из этих «технических 
ограничений». Я хотел, чтобы моя работа отражала 
это и работал над моим проектом как если бы две 
отдельные части моего фильма были двумя 
раздельными проектами, смешанными (pun inten-
ded) вместе. Я также сделал это, чтобы оценить 
масштаб, и почувствовал как велика «эмоциональ-
ная» часть. Это было единственной причиной того, 
что я сделал её первой, поскольку для этого мне 
требовалась музыка. Я закончил эту часть не менее 
чем за 2 недели до конца срока, так что у моего 
композитора, Derek McTavish Mounce, было время 
на создание шедевра, что он и сделал (спасибо, 
Дерек!).

Кстати, о сроках. Я создал небольшое расписа-
ние, чтобы сравнивать прогресс моей работы со 
временем, затраченным в действительности. На 
рисунке 2 можно увидеть как я организовал своё 
время. Как я ошибался... Я закончил эмоциональ-
ную часть в районе 28-го марта, в темпе отправил 
её Дереку, сам продолжил работу над технической 
частью в течение двух дней и закончил рендерить 
всё 4-го апреля, благодаря моему новому четырёх-
ядерному компьютеру.
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Дерек, определённо, работал гораздо интенсив-
нее и прислал мне готовую песню 6-го апреля в 
воскресенье, в три часа дня. Тогда я отправился в 
школу, где приступил к финальному монтированию 
со всеми моими отрендеренными файлами и сюжет-
ной музыкой Дерека, и закончил редактирование 
всего в полдень понедельника, более чем за 24 
часа до срока. Так что, в основном, проект был 
сделан. Теперь небольшое CGI-отступление.

С самого начала я знал, что полный рендеринг 
даже на моём четырёхядернике займёт кучу време-
ни. Так что я решил быть минималистом. Я не 
использовал никаких текстур, за исключением 
некоторых процедурных текстур для металличес-
кой части лампочки. Пройдите по ссылке в конце 
статьи, скачайте .blend-файл лампочки и посмотри-
те рисунок 3, чтобы увидеть мои настройки матери-
ала.

Текстура «brushedmetal» была применена с 
опцией «nor» для создания шершавой поверхности 
объекта. Использование очень простых процедур-
ных текстур и материалов значительно ускорило 
время рендеринга и помогло мне закончить работу 
вовремя. Тем же путём я пошёл при моделировании 
и освещении. Я придерживался минимума, доста-
точного для того, чтобы кадр выглядел хорошо 
(или хотя бы неплохо). Вот пример моего наиболее 
сложного освещения в фильме, во время переходно-
го эпизода между первой и второй частью, когда 
лампочка вставлена в своего рода проектор, из 
которого появляется персонаж.

Так как именно эта сцена должна была кон-
трастировать с предыдущей, более технической 
сценой, мне потребовалось вытолкнуть эмоции из 
лампы. Вот почему я использовал мощное цветовое 
освещение, красное и синее: как эти цвета противо-
стоят друг другу, так и техничность и креативность 
противопоставлены друг другу в моём фильме. 
Поскольку об использовании Ambient Occlusion 
для имитации глобального освещения не могло 
быть и речи в связи с длительным временем 
рендеринга, которого он требует, я поигрался с 
несколькими различными приёмами освещения для 
его имитации и остановился на использовании 
одной лампы (это почти и не трюк...) для смягче-
ния теней от двух других, очень мощных, ламп. 
Заметьте, как низко над горизонтом находятся эти 
две цветные лампы. Это сделано в основном для 
создания длинных теней, которые смешиваются с 
тенями, созданными другими лампами. Такой вид 
низкорасположенного (low angle) освещения добав-
ляет в сцену эмоций и драматизма, как это делает 
закат или восход. На рисунке 5 можно посмотреть 
эту сцену в отрендеренном виде. Для маленьких 
огоньков в углублении и вдоль пути лампочки, я 
просто разместил на объекте бестеневой белый ма-А
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териал, после чего добавил над ним «бестеневую» 
сферическую лампу.

Другой важной сценой была сцена «поля лампо-
чек», в которой персонаж пролетает сквозь 
примерно три тысячи лампочек, после чего они 
располагаются в форме круга (рисунки 6 и 7). Для 
генерации поля я воспользовался Генератором 
облаков Алана Денниса. Я просто сгенерировал с 
его помощью случайно размещённые на довольно 
большой площади вершины. Потом я присоединил 
туда мою модель лампочки, упростил её до самых 
главных деталей (убрал спираль внутри лампочки, 

убрал модификатор Subsurface, убрал отражение 
и преломление материала и т.д.) и произвёл над 
ним операцию Duplivert (меню объекта (F7)) на 
моё сгенерированное облако точек.

Теперь перейдём к разделу про прикольные 
узлы (funny node part).

Чтобы подсветить лампочки, я просто сдублиро-
вал меш облака и создал новый объект «halo», 
состоящий из единичной вершины с оранжевым 
материалом halo, после чего применил к нему 
операцию Duplivert на сдублированное облако, 
как я уже делал с лампочками. Потом я разместил 
эту новую систему на другом слое. На рисунке 8 вы 
видите систему узлов для этой сцены.

Как вы можете видеть, я разделил сцену на три 
раздельно рендерящихся слоя. Первым был слой 
рендеринга поля лампочек (на самом верху систе-А
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мы узлов). На нём я применил фильтр Defocus для 
создания эффекта глубины (который я использую 
на протяжении всего фильма), а также узел 
Brightness/Contrast для добавления моей сцене 
большей контрастности (ещё один быстрый трюк 
вместо использования более сложных установок 
освещения).

После этого я «добавил» («add») слой отрисов-
ки halo поверх слоя лампочек. Чтобы добавить 
немного больше цветения (bloom) этим halo, я 
размыл их и потом наложил с помощью «add» 
размытый halo поверх отрендеренных halo. И я 
воспользовался таким же приёмом для персонажа, 
чтобы придать ему немного лучший «wow effect» 
(это было сделано потому что базовая установка 
арматуры не настолько круто выглядит).

После всего этого, когда пришло время аними-
ровать все эти лампочки и придать им форму 
круга, я использовал дешёвый кинематографичес-
кий трюк. На протяжении перехода между двумя 
кадрами, я создал новый .blend, содержащий все 
те же самые объекты, размещённые примерно так 

же, как в предыдущем .blend. Вместо использова-
ния Duplivert я, однако, использовал систему 
частиц.

Так как каждый объект, составляющий облака 
(было 3 секции, формирующих целое облако) имел 
1870 вершин, я добавил к ним систему частиц, 
излучающую 1870 частиц. Потом я щёлкнул по 
кнопке «from: Verts» в меню системы частиц (и 
убедился, что кнопка «face» не выбрана). Я изме-
нил значения начала и окончания частиц на 0 и 1 
соответственно. Это заставило объект излучить все 
1870 частиц в один момент сразу перед стартом 
анимации на кадре 1. Я также убедился, что у них 
абсолютно нет скорости, так что все частицы оста-
вались на тех местах, куда были излучены. Тогда я 
использовал простой empty со свойством «Vortex 
field» и — вуаля! — мои частицы медленно сформи-
ровали круг. Так как я не хотел, чтобы они рас-
ширялись бесконечно, я просто создал новый 
.blend-файл с фрактально подразделённым цилинд-
ром, имеющим около двух тысяч вершин (в этой 
точке новый кадр не совпадает в точности с 
предыдущим).
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Заключение

В заключение, я хотел бы поблагодарить Джона-
тана Вильямсона за его помощь, критические 
замечания и мотивацию, предоставленные мне на 
протяжении той пары недель, когда я работал над 
этим. Убедитесь, что вы побывали на нашем сайте 
по адресу http://www.montagestudio.org и посмот-
рели не только мою короткометражку, но и работы 
Джонатана. Если у вас есть какие-то особые вопро-
сы по проекту, или вам нужны определённые 
файлы, я могу их вам предоставить, как только вы 
о них спросите. Этот проект создан с открытым 
сознанием и требует от зрителя сохранять своё 
сознание открытым на протяжении всех своих пяти 
минут, так что я не вижу никаких причин «закры-
вать» его контент. Единственная причина, удержи-
вающая меня от публикования всех этих файлов 
прямо сейчас, это время, которое требуется для 
упорядочивания файлов и папок и снабжения их 
текстовым описанием. Выпуск стольких файлов в 
отрыве от контекста не приведёт ни к чему 
хорошему, так что я не буду этого делать, пока не 
приведу их в порядок. Как я уже говорил, если у 
вас есть вопросы, пишите мне на 

jsguillemette@hotmail.com или jsguillemette@monta-
gestudio.org.

Объект лампочки: http://www.montagestu-
dio.org/Ecks/ProjectLightBulb/lightbulb.blend

Это персонаж в самой последней сцене: 
http://www.montagestudio.org/Ecks/ProjectLightBulb/
Character_LePenseur_jsguillemette.blend

Я надеюсь, вам понравилось читать эту статью 
так же, как мне создавать проект и писать её.
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Введение
С появлением реализации моделиро-

вания жидкости в Блендере, я увлечен 
реализмом создаваемого — это просто 
выглядит правильно. По нашему опыту, 
мы ожидаем, что жидкость всегда пере-
мещается под влиянием всех сил, 
воздействующих на неё, включая грави-
тацию, пока она, наконец, не достигнет 
стабильного состояния, если это возмож-
но. Очень любопытно, что у водопада, 
например, форма изгиба (определяемая 
по большей части движущей силой и гра-
витацией) статична, тогда как поток 
динамический.

Жидкое Искусство: идея.
Чего я не видел среди различных 

демонстраций симуляции жидкости в 
онлайне, так это чего-то похожего на 
водный фонтан, где вода должна течь 
вверх и падать вниз, и вода приобретает 
форму, в противоположность покою, где 
её не должно быть. Умный фонтан, я 

подумал, должен интриговать своей повышенной 
сложностью. Простая реализация этого в Блендере 
должна иметь:

Несколько объектов источников 
потока (inflow)

• Каждый с той же вертикальной скоростью 
потока (Z)

• Каждый со специфической горизонтальной 
скоростью потока (X и Y), чтобы общий 
эффект был интереснее

Я решил использовать шестнадцать объектов 
источников, размещенных по кругу, как видно 
выше, и направил каждый поток вверх и по на-
правлению к центру. Затем, в центре все потоки 
должны столкнуться и перестать перемещаться в 
горизонтальном направлении, чтобы осталось толь-
ко вертикальное движение (вниз). Если вы предста-
вите себе это, это похоже на дерево со стволом и 
ветками.

Отправной пункт: как 
имитированный поток жидкости 
себя ведет?

В этом месте, нужна некоторая специфическая 
информация о расстоянии и форме потока для дан-
ной скорости жидкости. Я сделал много эксперимен-
тов с одним потоком, чтобы найти простые 
значения геометрии и скорости. Вот скриншот 
удовлетворительных результатов, вид сбоку (рису-
нок 2). Объектом источника потока (inflow) был 
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кубик небольшого размера, чтобы сделать узкий 
поток, имеющий Z-скорость 1 (вверх) и X-скорость 
1 (положительный, направо), и Y-скорость 0. 
Важно отметить две вещи: (1) поток пересекает 
начало координат, поскольку позже, это место 
станет центром круга источников потока; (2) 
конечное разрешение сетки домена (domain mesh) 
должно быть по возможности высокое; я был 
способным достичь 200.

Два потока сталкиваются: жид-
кость также становится препятс-
твием.

Чтобы созда-
вать второй поток, 
я сделал зеркаль-
ную копию перво-
го потока через 
начало координат, 
сделал симуляцию 
и проверил резуль-
тат на наличие 
разумного пересе-
чения двух пото-
ков в центре. Два 
потока объединя-
лись довольно хо-
рошо и потекли 
вниз в центре. 
Второй объект источника имел ту же Z-скорость, но 
с X-скоростью -1 (отрицательной, налево), и Y-
скорость 0.

Расширение: делается 
математически.

Конечной конфигу-
рацией источников 
потока было шестнад-
цать кубиков, равноу-
даленных вдоль 
окружности, отцентри-
рованной в начале 
координат, как рас-
смотрено из выше. 
Каждый объект источ-
ника требовал 
расчета компонент 
скорости X и Y, кото-
рый я не включил 
здесь, только отмечу, что величина общей горизон-
тальной скорости равнялась 1, и направление было 
к центру. Результат выпечки этой настройки, дал 
желаемую форму дерева.

Добавление некоторого цвета: 
фальшивый материал — это не 
легко.

Подобно разработке водяных фонтанов для 
показа вечером, освещение является частью искус-
ства. Я добавил цветные прожекторы (spotlights) 
выше в стратегических позициях, чтобы дать зе-
леные отражения на ветках, и распределённые по 
поверхности источники света (area lights) вдоль 
ствола для коричневых отражений. Трудность этого 
метода — ограничение каждого цвета в 
специфические части дерева, без перекрытия. 
Чтобы иметь полное преимущество в световых 
настройках, я изменил настройки материала по 
умолчанию. На панели «Shader» я установил А
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суммарное отражение (amount of reflection) в 1, 
степени Specularity в 2, и твердость (hardness) в 
1.

Вывод: и вызов.
Я рендерил несколько секунд этой симуляции. 

Изумительно. Было очевидно, что эффект работа-
ет. Этот проект был трудным и, в то же самое 
время, забавным. Что удовлетворило мое любопыт-
ство, это хорошие результаты функции Блендера 
симуляции жидкостей. И это увлекательно, наблю-
дать как текущая жидкость формирует знакомую, 
или по крайней мере, интересную форму.

Мой вызов любому читателю — он должен 
попробовать сделать это с другой геометрией, ско-
ростями, освещением, материалами, и даже исполь-
зовать кривые IPO, чтобы менять скорости 
жидкости со временем. И проведёте хорошо время.

Jack Harris (okchoir) is a retired electrical engineer 
of northern Texas, USA, and has been using Blender 
since 2004. He enjoys choir singing and reading, 
and is currently building a steel-framed, retirement 
home.
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